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1 Overview

NotePager Pro is a sophisticated wireless messaging (paging) application.  It is capable of delivering
messages to an unlimited number of recipients (pagers, mobile phones, PIMs, etc.) and/or groups. 
NotePager Pro includes advanced features such as scheduled messages, repeating messages, pre-
programmed messages, on-call groups, ad-hoc paging, etc.  NotePager Pro supports all of the current
paging (wireless messaging) protocols (FAX, GSMAT, SMTP, SNPP, TAP, TONE, UCP, and WCTP).
Messages can be sent via a standard analog modem, a wireless modem, supported mobile phones, or
an Internet connection. All of NotePager Pro's features are containded within an easy-to-use and intuative
graphical interface.

There is a certain logic and an order of operations to things and there are several terms you'll want to
familiarize yourself with.

Within NotePager Pro, you'll be configuring Carriers, Recipients and Groups.

A carrier is a company that provides the service for a wireless device (pager, phone, PIM, etc.).  They control the
antennas, satellites, broadcast, and computer systems that are used to send the messages to your cell
phones and pagers.  

A recipient is a person or system whose cell phone, pager or email address you want to message.

A group is a collection of recipients.

So, in order to send messages, you will need to configure a Carrier, then tie a Recipient to the Carrier. Once
you have Recipients configured in the program, you can then create Groups.
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2 Quick Start Guide

Getting to know the NotePager Pro interface is an integral part of stepping in to the world of sending
SMS, email, page, fax and other types of messages. There are many different pieces of information you'll
need to gather and several things you'll need to configure in order to send a message. Once you
familiarize yourself with the NotePager Pro interface, you'll find it's easy to get your messages to your
people when they need them.

The first step is to install the program.

After installing the program and running it for the first time, you'll see this screen:

If you've purchased the program, click on the Register button to register the software. Click here for more
information on how to register the program.

If you have not purchased the program, click on Continue to proceed to the NotePager Pro Interface.
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2.1 Features & Capabilities

Multiple Protocol Support - all the standard wireless messaging protocols are supported: (GSMAT,
SMTP, SNPP, TAP (IXO/PET), TONE, UCP, WCTP, in addition, email and faxing protocols are
supported)

Scheduled messages - messages can be scheduled to be sent at a future date/time

Repeating messages - messages can be scheduled to repeat at predefined interval, for a settable period
of time

Group paging - messages can be sent to a predefined group of recipients

Multiple recipients - allows a single message to be sent to more than one recipient and/or  group 

Pre-programmed messages - on each workstation, up to 100 pre-programmed messages can be defined

Real-time message status logs - each workstation can track the progress of each message from start to
finish

Real-time message status counters - displays current number of messages scheduled, pending, sent, or
failed from each workstation

Message history log - displays a history of all messages sent from each workstation

Intelligent message queuing - messages for the same carrier are grouped together and sent during a
single communications session

Point and click operation - an intuitive user interface makes the NotePager Pro very easy to use 

Spell check - a spell check option is available on systems running MS Word 

Message splitting - Long messages are intelligently split into multiple smaller messages

Settable character limits - The maximum number of characters to be sent in a message is settable by
carrier and individual recipient

On-call groups - A schedule can be setup for the recipients in a group, allowing NotePager Pro to send
messages to only the recipients scheduled to receive messages a that point in time.

Message logging - NotePager Pro keeps a detailed log of the communication sessions with the paging
carriers.

Requeue messages - missed messages can be requeued for re-transmission to the paging carrier

Reporting - extensive reporting capabilities, including writing reports to text file

Security - three levels of password protection

Import/Export - import and export support for other NotePage products and other file formats

User-Definable fields - extra data fields can be used with each recipient for informational or filtering
purposes
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2.2 The NotePager Pro Interface

The NotePager Pro interface can be broken down in to several sections:

Menus

Click here to go to the Menus section of the documentation.
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Recipient Selection

A Recipient could be someone's cell phone, pager, their email address, a fax machine or several other
things. This section of the interface is used to select the recipients and groups you want to send your
message to. When you select a recipient or group, it will be moved to the Selected Recipients dialog.
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Message

When you have a message you want to deliver, enter it in to this section of the interface. Click here for
information on how to send messages.
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Buttons

Click here to go to the Buttons section of the documentation.
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2.2.1 Buttons

Placed throughout the NotePager Pro interface are several buttons that perform different functions.

Along the top of the interface, you will see these buttons:

This button will cancel pending messages.

This button shows a list of all scheduled messages.

This button shows a list of all pending messages.

This button shows a list of all sent messages.

This button shows a list of all bad messages.

This button will display the entire message history.

This button will access the Activity Log.

This button will toggle the Activity Monitor on and off.
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On the right hand side of the interface, you will see these buttons:

This button will clear the recipients out of the Selected Recipients list.

This button will clear the Message Text box.

This button provides the ability to schedule messages to go out at a future date and time.
This function also allows you to configure messages that repeat at a specified interval

This button sends the message in the Message Text box to the recipients in the
Selected Recipients list.

Along the bottom of the interface, you will see these buttons:

These buttons represent your preset messages. For more information on how to configure preset
messages, click here.
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2.3 Using NotePager Pro

Now that you've familiarized yourself with the NotePager Pro interface and its associated buttons, it's
time to configure the program to send messages to your people. In order to do that, you're going to need
some information.

First, what wireless carrier do the devices you want to send to use? 

For cell phones, a carrier could be Verizon, AT&T, T-Mobile, US Cellular, etc. The most common delivery
protocol supported by cell phone carriers is SMTP. Click here for information on how to configure an
SMTP carrier.

For pagers, a carrier could be USA Mobility, American Messaging, Skytel, etc. The most common
delivery protocol supported by paging carriers is SNPP. Click here for information on how to configure an
SNPP carrier.

For email addresses, the carrier will be Email. Click here for information on how to configure an Email
carrier.

Second, what phone numbers or email addresses do you want to send to?

Once you have that information, you can use it to create a recipient that's tied to one of the carriers
you've created. Click here for information on how to add a recipient.

After you have at least one carrier and recipient in the program, you can start sending messages. Click
here for information on how to send amessage.

There are also many different functions that you may find useful.

Click here for information on how to schedule messages to go out at a future date and/or repeat.

Click here for information on how to configure preset messages.

2.3.1 How to Send Messages

After creating your carriers, recipients and groups, you will have a list of available recipients in the
Recipients section of the NotePager Pro interface.
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To send a message to a recipient or group, click on their name in the Recipients list to move them in to
the Selected Recipients section.
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Then type a message in the Message Text box.
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Then click on the Send button to queue the message(s) for delivery.
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2.3.2 How to Schedule Messages

After creating your carriers, recipients and groups, you will have a list of available recipients in the
Recipients section of the NotePager Pro interface.
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To schedule a message to a recipient or group, click on their name in the Recipients list to move them in
to the Selected Recipients section.
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Then type a message in the Message Text box.
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Then click on the Scheduling Calendar button to access the scheduling function.
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Specify the date and time at which this message should be sent. If this message should repeat, put a
check in "Repeating Message" and specify the interval at which the message should repeat, then specify
the date and time when the message should stop being sent.

Then click on the Apply button to go back to the main interface.
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Then click on the Send button to finalize the message schedule.
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You should then see the Sched section increment with the number of scheduled messages.

Click here for information on how to view and edit your list of scheduled messages.
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2.3.3 How to Cancel Messages

To cancel all pending messages in the queue, right click on the Pend category along the bottom of the
NotePager Pro interface.

The program will then bring up a prompt asking if you want to cancel all pending messages.

For information on how to cancel a specific message in the pending queue, click here.
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2.3.4 Using Preset Messages

So, let's say that you know you're going to have to type the same message over and over and over.
Instead of doing that, you can create a preset to make your life easier. 

Along the bottom of the NotePager Pro interface, you'll see these buttons.

These buttons allow you to configure preset messages. Here's how:

First, right click on one of the available preset message buttons to access the Preset Messages dialog.

Within this dialog, you can rename the text of the displayed button, specify a recipient or group that the
preset message should default to send to and enter the text of your preset message. 

When you have finished specifying the modifications to your preset message, click on Apply.
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To use your preset message, simply click on the preset button you wish to use.
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To use the example I created earlier, if I click on the ALERT button, it will automatically propagate the
Selected Recipients and Message Text.
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Then click on the Send button to deliver your message(s).

Displayed along the NotePager Pro Window are the buttons for the first five preset messages and a sixth
button called More. Clicking on the More button will provide a list of all preset messages in the dialog
below.
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3 General Information

NotePager Pro is a sophisticated wireless messaging (paging) application.  It is capable of delivering
messages to an unlimited number of recipients (pagers, mobile phones, PIMs, etc.) and/or groups. 
NotePager Pro includes advanced features such as scheduled messages, repeating messages, pre-
programmed messages, on-call groups, ad-hoc paging, etc.  NotePager Pro supports all of the current
paging (wireless messaging) protocols (FAX, GSMAT, SMTP, SNPP, TAP, TONE, UCP, and WCTP).
Messages can be sent via a standard analog modem, a wireless modem, supported mobile phones, or
an Internet connection. All of NotePager Pro's features are containded within an easy-to-use and intuative
graphical interface.

There is a certain logic and an order of operations to things and there are several terms you'll want to
familiarize yourself with.

Within NotePager Pro, you'll be configuring Carriers, Recipients and Groups.

A carrier is a company that provides the service for a wireless device (pager, phone, PIM, etc.).  They control the
antennas, satellites, broadcast, and computer systems that are used to send the messages to your cell
phones and pagers.  

A recipient is a person or system whose cell phone, pager or email address you want to message.

A group is a collection of recipients.

So, in order to send messages, you will need to configure a Carrier, then tie a Recipient to the Carrier. Once
you have Recipients configured in the program, you can then create Groups.

3.1 Trial Mode Information

NotePager Pro defaults into an evaluation mode until it is registered (purchased). Registration information
can be entered into NotePager Pro by choosing 'Registration' from its 'Help' menu.  The evaluation
version of NotePager Pro will stop running after 30 days of use.

NotePager Pro is based on the try it before you buy it concept. This software is not free. You may try it.
If you like the software and would like a complete registered version you must contact
sales@notepage.com. The registration fee allows us to continue to develop quality products, notify you
of updates, and provide technical support. NotePage, Inc. accepts credit cards (Visa, MasterCard,
Discover & American Express), Purchase Orders, and checks drawn on US banks. If you have any
questions or concerns regarding registration please contact sales@notepage.com. If you use any of
NotePage, Inc.'s software and do not register after the trial period it is considered software piracy and is
illegal.

3.2 Purchasing

NotePager Pro can be ordered directly from NotePage, Inc:

NotePage, Inc.
PO Box 296
Hanover, MA 02339

Phone (781) 829-0500
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Fax (781) 829-0419 

Accepted Payment forms are:
Pre-payment
COD Company Check (continental US only)
American Express
Discover
MasterCard
Visa
Purchase Orders (continental US only)

All payments are in US Dollars

NotePager Pro can be ordered on-line at:

www.notepage.net/notepagerpro.htm

Accepted Payment forms are:
American Express
Discover
MasterCard
Visa

NotePager Pro can be purchased through a NotePage authorized reseller, who can also be contracted
for the installation of our products.  Please contact us for a reseller in your area.

3.3 Contact Information

NotePage, Inc.
PO Box 296
Hanover, MA  02339
USA

Mailing Address
PO Box 296
Hanover, MA  02339

Web www.notepage.net
Email sales@notepage.com
Phone (781) 829-0500
Fax (781) 582-1869

3.4 End User License Agreement

END-USER LICENSE AGREEMENT FOR NOTEPAGER PRO

IMPORTANT PLEASE READ THE TERMS AND CONDITIONS OF THIS LICENSE AGREEMENT
CAREFULLY BEFORE CONTINUING WITH THIS PROGRAM INSTALL:  
NotePage, Inc.'s End-User License Agreement ("EULA") is a legal agreement between you (either an
individual or a single entity) and NotePage, Inc. for the NotePage software product(s) identified above
which may include associated software components, media, printed materials, and "online" or electronic
documentation ("SOFTWARE PRODUCT"). By installing, copying, or otherwise using the SOFTWARE
PRODUCT, you agree to be bound by the terms of this EULA. This license agreement represents the
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entire agreement concerning the program between you and NotePage, Inc., (referred to as "licensor"),
and it supersedes any prior proposal, representation, or understanding between the parties.  If you do not
agree to the terms of this EULA, do ot install or use the SOFTWARE PRODUCT. 

The SOFTWARE PRODUCT is protected by copyright laws and international copyright treaties, as well
as other intellectual property laws and treaties. The SOFTWARE PRODUCT is licensed, not sold. 

1. GRANT OF LICENSE.  The SOFTWARE PRODUCT is licensed as follows: 
(a) Installation and Use. NotePage, Inc. grants you the right to install and use copies of the SOFTWARE
PRODUCT on your computer running a validly licensed copy of the operating system for which the
SOFTWARE PRODUCT was designed [e.g., Windows 95®, Windows 98®, Windows ME®, Windows
NT®, Windows 2000®, Windows XP®]. 
(b) Per Computer License. Ownership of The SOFTWARE PRODUCT only permits for The SOFTWARE
PRODUCT to be installed on a SINGLE computer. Ownership of The SOFTWARE PRODUCT only
permits for a SINGLE instance of The SOFTWARE PRODUCT to be run said computer. For use of The
SOFTWARE PRODUCT on additional computers, or for use of more than one instance of The
SOFTWARE PRODUCT on a single computer, additional licenses MUST be purchased. 
(c) Backup Copies. You may also make copies of the SOFTWARE PRODUCT as may be necessary for
backup and archival purposes. 

2. DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS. 
(a) Maintenance of Copyright Notices.You must not remove or alter any copyright notices on any and all
copies of the SOFTWARE PRODUCT. 
(b) Distribution. You may not distribute registered copies of the SOFTWARE PRODUCT to third parties. 
Evaluation versions available for download from NotePage, Inc.'s websites may be freely distributed.
(c) Prohibition on Reverse Engineering, Decompilation, and Disassembly. You may not reverse engineer,
decompile, or disassemble the SOFTWARE PRODUCT, except and only to the extent that such activity
is expressly permitted by applicable law notwithstanding this limitation. 
(d)  Rental. You may not rent, lease, or lend the SOFTWARE PRODUCT. 
(e) Support Services. NotePage, Inc. may provide you with support services related to the SOFTWARE
PRODUCT ("Support Services").  Any supplemental software code provided to you as part of the Support
Services shall be considered part of the SOFTWARE PRODUCT and subject to the terms and conditions
of this EULA.  
(f) Compliance with Applicable Laws. You must comply with all applicable laws regarding use of the
SOFTWARE PRODUCT. 

3. TERMINATION
Without prejudice to any other rights, NotePage may terminate this EULA if you fail to comply with the
terms and conditions of this EULA. In such event, you must destroy all copies of the SOFTWARE
PRODUCT in your possession. 

4. COPYRIGHT
All title, including but not limited to copyrights, in and to the SOFTWARE PRODUCT and any copies
thereof are owned by NotePage, Inc. or its suppliers. All title and intellectual property rights in and to the
content which may be accessed through use of the SOFTWARE PRODUCT is the property of the
respective content owner and may be protected by applicable copyright or other intellectual property laws
and treaties.  This EULA grants you no rights to use such content.  All rights not expressly granted are
reserved by NotePage. 

5. NO WARRANTIES
NotePage, Inc. expressly disclaims any warranty for the SOFTWARE  PRODUCT. The SOFTWARE
PRODUCT is provided "As Is" without any express or implied warranty of any kind, including but not
limited to any warranties of merchantability, noninfringement, or fitness of a particular purpose. NotePage
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does not warrant or assume responsibility for the accuracy or completeness of any information, text,
graphics, links or other items contained within the SOFTWARE PRODUCT.  NotePage makes no
warranties respecting any harm that may be caused by the transmission of a computer virus, worm, time
bomb, logic bomb, or other such computer program. NotePage further expressly disclaims any warranty
or representation to Authorized Users or to any third party.
 
6. LIMITATION OF LIABILITY
In no event shall NotePage, Inc. be liable for any damages (including, without limitation, lost profits,
business interruption, or lost information) rising out of 'Authorized Users' use of or inability to use the
SOFTWARE PRODUCT, even if NotePage, Inc. has been advised of the possibility of such damages.  In
no event will NotePage be liable for loss of data or for indirect, special, incidental, consequential
(including lost profit), or other damages based in contract, tort or otherwise. NotePage, Inc. shall have no
liability with respect to the content of the SOFTWARE PRODUCT or any part thereof, including but not
limited to errors or omissions contained therein, libel, infringements of rights of publicity, privacy,
trademark rights, business interruption, personal injury, loss of privacy, moral rights or the disclosure of
confidential information.
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4 Installation

Minimum requirements to run NotePager Pro:

NotePager Pro can run on Windows XP (sp3) and newer versions of the Microsoft Windows operating
system 

Memory: 32 Mb of free memory (before NotePager Pro is running)

Storage: 50 Mb of free disk space (for application and data)

Communications:  a 300 baud or faster analog modem for dialup connections, a supported wireless
modem, a supported mobile phone, or an active Internet connection.

4.2 Installation Instructions

Please reference the Windows 7, 8, Server 2008 and Server 2012 portion of the manual to
install on those operating systems.

Please reference the Windows XP and Server 2003 portion of the manual to install on
those operating systems.

4.2.1 Windows Vista, 7, 8, Server 2008 and Server 2012 Instructions

There are two primary ways to install NotePager Pro:

Installation by CD-Rom

Installation by Download

4.2.1.1 CD-Rom Installation

1) Insert the NotePager Pro CD-Rom into your computer.

2) NotePager Pro's setup routine will (on most computers) automatically start. Cancel the auto-run.

3) In Windows, browse to your CD Drive.

4) Right click on the notepagerpro.exe file, left click on "Run As Administrator".
NOTE: YOU MUST DO THIS. If you try to run the installation normally, the User Accounts Control
security feature of your operating system will prevent the program from functioning properly.

5) Click on Next.

6) In the next portion of the setup, you will be given the option to view the Readme and Release Notes
files. If you choose to display either file, they will be shown when you hit 'Next'.

7) The following screen will display NotePager Pro's End User License Agreement. Please read it
carefully and proceed with the installation of NotePager Pro only if you agree with all the terms of this
agreement.

8) On the next screen you can specify a location where you want NotePager Pro installed. The default
install location is C:\Program Files (x86)\NotePager Pro\
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You can change the installation path by hitting the 'Browse' button. When you have specified the path
to install to, click on Next.

9) You will now be prompted for the name of the group that the NotePager Pro icons should be added to
in the Windows Start Menu. The default group is 'NotePager Pro'.

10) Select whether you would like a shortcut created on your desktop, then click on Next.

11) Click on Install

12) When the installation finishes, click on Finish.

4.2.1.2 Installation by Download

1) Download the latest installation file for NotePager Pro: http://www.notepage.net/download/
notepagerpro.exe

2) When asked if you want to run or save it, you want to Save it to the Desktop.

3) After the installation file has downloaded, minimize and/or close everything until you can see the
desktop.

4) Right click on notepagerpro.exe 

5) Select the "Run as Administrator" option.
NOTE: YOU MUST DO THIS. If you try to run the installation normally, the User Accounts Control
security feature of your operating system will prevent the program from functioning properly.

6) Click on Next on the first step.

7) Click on Next on the second step.

8) On the third step, review the End User License Agreement, then select "I accept the agreement" and
click on Next.

9) Click on Browse on the fourth step.

10) At the top, change C:\Program Files (x86)\NotePager Pro\ to c:\NotePager Pro\

11) Click on OK.

12) Click on Next.

13) Click on Next until the installation finishes.

14) Click on Finish. 

http://www.notepage.net/download/notepagerpro.exe
http://www.notepage.net/download/notepagerpro.exe
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4.2.2 Windows XP and Server 2003 Instructions

There are two primary ways to install NotePager Pro:

Installation by CD-Rom

Installation by Download

4.2.2.1 CD-Rom Installation

1) Insert the NotePager Pro CD-Rom into your computer.

2) NotePager Pro's setup routine will (on most computers) automatically start. 

3) Click on "Install NotePager Pro"

4) Click on Next.

5) In the next portion of the setup, you will be given the option to view the Readme and Release Notes
files. If you choose to display either file, they will be shown when you hit 'Next'.

6) The following screen will display NotePager Pro's End User License Agreement. Please read it
carefully and proceed with the installation of NotePager Pro only if you agree with all the terms of this
agreement.

7) On the next screen you can specify a location where you want NotePager Pro installed. The default
install location is C:\Program Files (x86)\NotePager Pro\
You can change the installation path by hitting the 'Browse' button. When you have specified the path
to install to, click on Next.

8) You will now be prompted for the name of the group that the NotePager Pro icons should be added to
in the Windows Start Menu. The default group is 'NotePager Pro'.

9)  Select whether you would like a shortcut created on your desktop, then click on Next.

10) Click on Install

11) When the installation finishes, click on Finish.

4.2.2.2 Installation by Download

1) Download the latest installation file for NotePager Pro: http://www.notepage.net/download/
notepagerpro.exe

2) When asked if you want to run or save it, you want to Save it to the Desktop.

3) After the installation file has downloaded, minimize and/or close everything until you can see the
desktop.

http://www.notepage.net/download/notepagerpro.exe
http://www.notepage.net/download/notepagerpro.exe
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4) Double click on the installation file to run it.

5) Click on Next on the first step.

6) Click on Next on the second step.

7) On the third step, review the End User License Agreement, then select "I accept the agreement" and
click on Next.

8) Click on Browse on the fourth step.

9) At the top, change C:\Program Files (x86)\NotePager Pro\ to c:\NotePager Pro\

10) Click on OK.

11) Click on Next.

12) Click on Next until the installation finishes.

13) Click on Finish. 

4.2.3 Installation Troubleshooting

For assistance in troubleshooting errors in the installation, please contact our Support Department:

http://www.notepage.net/forum/ 
support@notepage.com

http://www.notepage.net/forum/
mailto:support@notepage.com
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5 The Menus

The menus for
NotePager Pro
are:

File

Tools

Carriers

Recipients

Groups

View

Reports

Help
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5.1 File

The File menu
for NotePager
Pro provides
the following
options:

Import

Export

Register

Exit
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5.1.1 Import

The Import
function
allows you to
take
information
from other
applications
and bring it in
to NotePager
Pro.

NotePager
Pro can
import from:

Text File

PageGate

5.1.1.1 Importing From Text Files

The  Import  function  allows
you to take information from
other  applications  in  a
Comma  Separated  Values
text  file  and  bring  it  in  to
NotePager Pro.

NotePager Pro can import:

Carriers

Recipients

Groups

Group Members

Note: The import files  MUST
be  in  a  Comma  Separated
Values  format  and  MUST
match  the  specific
NotePager  Pro  data
structure.
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5.1.1.1.1  Importing Carriers from a Text File

To import a Comma Separated Values text file in to NotePager Pro to add or update Carriers, the file
must be formatted very, very specifically.

The specific data structure of each record is as follows:

"Version","Name","PhoneNumber","ModemSettings","MaxChars","InitString","MessageLimit","DialType",
"AuthType","AuthUser","AuthPassword","RelayMail","RelayServer","Priority"

Field Description and Values

Version This field declares the version of the import file and should be set to: 500

Name
This field assigns the name of the carrier to be imported.  Names should be assigned
with alphanumeric characters. Special characters such as ! @ # $ %  ̂& * ( ) +  = [  ]
{ } / ? \ | ; : ' " , < > and spaces are disallowed from this field.

PhoneNumb
er

This field value means different things for different protocols.

If this  carrier is  configured to use a dialing protocol (TAP, TONE or  UCP),  this  field
declares the phone number to dial.

If this carrier is configured to use the SMTP protocol,  this  field declares  the Sending
Domain and  MUST match  the  email  domain  of  the  network  on  which  the  PC is  a
member.

ModemSetti
ngs

This field value means different things for different protocols.

If this  carrier is  configured to use a dialing protocol (TAP, TONE or  UCP),  this  field
declares  communication  parameters  to  use  and  should  be  set  to:
BaudRate,Parity,DataBits,StopBits. For example: 1200,e,7,1

If this  carrier is  configured to use the SMTP protocol,  this  field declares  the  port  to
use.

MaxChars
This  field assigns the maximum number of characters  that  can  be  sent  in  a  single
message. For an SMS carrier,  this  value should be set  to 160.  For a paging carrier,
this value should be set to 240.

InitString

If this  carrier is  configured to use a dialing protocol (TAP, TONE or  UCP),  this  field
declares  initialization  string  for  your  modem.  If  you  are  unsure  what  initialization
string to use, including parenthesis, enter the value: (auto)

If this  carrier is  NOT configured to use a dialing protocol,  leave this  field as  a  blank
string value ("").

MessageLi
mit

This field declares whether or not this carrier has a maximum number of messages it
can  receive  before  the  connection  is  closed  and  further  messages  are  sent  on
successive  connections.  If  this  carrier  does  not  have  a  message  limit,  enter  the
value: 0

DialType This field declares the protocol to use. 
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Protocol Required Value

FAX fax

FAXSRV fxs

GSMAT gsm

SMTP eml

SNPP snp

TAP tap

TONE tone-,,@

UCP ucp

WCTP wct-0

AuthType

If required by a carrier, this field declares the authentication type.

Value Authentication Type
0 No Authentication

1

Standard.

In SMTP, the authentication used is based on what type the SMTP
server  reports  that  it  supports  after  the  EHLO  command  is  sent.
Order  of  preference  if  more  than  one  form  is  supported  by  the
server: CRAM-MD5, PLAIN, LOGIN.

In SNPP, the LOGI command used.

In WCTP, the senderID (AuthUser field is  used)  and  securityCode
(AuthPassword field is used) data fields are used/sent.

In TAP, the password (AuthPassword field is  used) is  sent  as  part
of the PG1 response.

In UCP, the password (AuthPassword field is  used)  is  included  in
the data sent.

2

Sender Override

In SMTP, the AuthUser field value is  used in the Mail From field in
the SMTP envelope.

In  WCTP,  the  AuthUser  field  value  is  used  in  the  senderID  data
field that is sent.

3

CRAM-MD5

In SMTP, the CRAM-MD5 type authentication is  used,  even  if  the
server doesn't advertise that it is supported.

4

PLAIN

In SMTP, the PLAIN type authentication is  used,  even if the server
doesn't advertise that it is supported.

5
LOGIN
In SMTP the LOGIN type authentication is  used,  even if the server
doesn't advertise that it is supported.

6

NTLM

In SMTP, the NTLM type authentication is  used,  even if the server
doesn't advertise that it is supported.
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11

WCTP-MISCINFO

In  WCTP,  the  senderID  (AuthUser  field  is  used)  and  miscInfo
(AuthPassword field is used) data fields are used/sent.

12
WCTP-RECIPIENT

In WCTP, the Sender's email address is used for the senderID field

AuthUser
If this  carrier will  be using  authentication  and  the  authentication  method  requires  a
username, enter it in this field.

AuthPassw
ord

If this  carrier will  be using  authentication  and  the  authentication  method  requires  a
password, enter it in this field.

RelayMail

If  this  carrier  is  configured  to  use  the  SMTP  protocol,  this  field  value  determines
whether this carrier uses the direct send method of delivery or needs to relay  through
an SMTP server.  This  field value  should  be  set  to  #FALSE#  if  direct  send  it  being
used and should be set to #TRUE# if this carrier should relay.

If this carrier is NOT configured to use SMTP, leave this  field as  a blank string value
("").

Relayserver

If this  carrier is  configured to use the SMTP protocol and needs to relay  through an
SMTP server, this field value declares the SMTP server to use.

If this carrier is NOT configured to use SMTP, leave this  field as  a blank string value
("").

Priority
This field value must be set to a value from 1 to 100,  with 1 representing the highest
priority. The default  value all  carriers  and recipients  is  100,  however,  numbers  larger
than 100 can be used. The default value is 100.

This is an example of an import record that would import a carrier named 'ATT' that's set to use the TAP
protocol to dial the AT&T TAP terminal 18009094602 with a baud rate of 1200, parity of even, data bits of
7, stop bits of 1, automatic initialization string and authentication is not required:
"500","ATT","18009094602","1200,e,7,1","160","(auto)","0","tap","0","","",#FALSE#,"","100"

This is an example of an import record that would import a carrier named 'Email' that's set to use the
SMTP protocol over port 25 with a declared sending domain where relaying is enabled, authentication is
required and a username and password are declared:
"500","Email","sendingdomain.com","25","160","","0","eml","1","username","password",#TRUE#,"relayse
rveraddresshere","100"

5.1.1.1.2  Importing Recipients from a Text File

To import a Comma Separated Values text file in to NotePager Pro to add or update Recipients, the file
must be formatted very, very specifically.

The specific data structure of each record is as follows:

"Version","Name","FullName","Id","Carrier","MaxChars","Alpha","OnCall","AdHoc","DropControl","Group"
,"SendSubject","RemoveFrom","Extra1","Extra2","Priority"
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Field Description and Values

Version This field declares the version of the import file and should be set to: 500

Name

This field assigns the Short  Name of the recipient  to be imported.  Names should
be assigned with alphanumeric characters. Special characters such as ! @ # $ %
^ & * ( ) +  = [  ]  { } /  ? \  | ;  :  ' "  ,  <  > and spaces  are  disallowed  from  this  field.
Underscores and dashes can be used.

FullName

This field assigns the Full Name of the recipient to be imported. Names should be
assigned with alphanumeric characters. Special characters  such as  ! @ # $ % ^
& * ( ) + = [ ] { } / ? \ | ; :  ' "  <  > are disallowed from this  field.  Spaces,  commas,
underscores and dashes can be used.

Id

This  field  declares  the  contact  address  or  phone  number  of  the  recipient.  For
example,  if this  recipient  will  be tied to an SMTP/Email carrier,  you would either
enter  an  email  address  or  a  cell  phone  contact  address
(ex;7818290500@vtext.com).  If  this  recipient  will  be  tied  to  a  non-SMTP/Email
based carrier,  enter the 10  digit  cell  phone  or  pager  number  with  no  spaces  or
dashes (ex;7818290500).

Carrier
This  field declares  the name of  the  Carrier  that  this  recipient  should  be  tied  to.
This  field  value  MUST  exactly  match  the  name  of  a  carrier  that  exists  within
NotePager Pro.

MaxChars

This field determines the maximum number of characters you wish to send to this
recipient.  If the recipient  Max  Chars  value  is  higher  than  the  carrier  Max  Chars
value,  the program will  break up long messages in  to  multiple  messages  based
on the carrier's character limit.

Alpha

If this recipient is device that can only  receive numeric  characters,  this  field value
should be set to: #FALSE#

All other recipients should have this field value set to: #TRUE#

OnCall

For the Recipients import, this field value should be set to #FALSE#

If this recipient needs to be a part  of an On-Call Group,  that  configuration should
be done from within the NotePager Pro interface.

AdHoc
If this recipient is an Ad-Hoc recipient, set this value to: #TRUE#

If this recipient is a normal recipient, set this value to: #FALSE#

DropControl

This field value corresponds to the "Strip non-printable characters"  value within a
recipient's settings. Non-printable characters  are things like carriage returns,  line
feeds, horizontal tabs and the like.

If you want  these  characters  to  appear  in  messages  sent  to  this  recipient,  set
this value to: #FALSE#

If you do not want these characters to appear in messages sent  to this  recipient,
set this value to: #TRUE#

Group For the Recipients import, set this value to: #FALSE#

SendSubject
This  field  value  corresponds  to  the  "Extract  Subject"  value  within  a  recipient's
settings.
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If this value is set to #TRUE#, NotePager Pro will search the first 40 characters  of
any message sent  to  this  recipient  for  a  carriage  return  and  line  feed,  carriage
return, or line feed. If it finds a match, it will treat anything before those characters
as the subject line of the message.

If this value is set to #FALSE#, NotePager Pro will use a default  subject  of:  TEXT
MESSAGE

RemoveFrom

This field value corresponds to the "Strip sender's name" value within a recipient's
settings.

If you want  for the sender's  name to prefix  messages  sent  to  this  recipient,  set
this value to: #TRUE#

If you do not want for the sender's name to prefix messages sent to this  recipient,
set this value to: #TRUE#

Extra1
This  field corresponds to the Comment1 field within a recipient's  settings.  If  you
want to leave a comment about this recipient, enter it here.

Extra2
This  field corresponds to the Comment2 field within a recipient's  settings.  If  you
want to leave a secondary comment about this recipient, enter it here.

Priority
This  field  value  must  be  set  to  a  value  from  1  to  100,  with  1  representing  the
highest  priority.  The  default  value  all  carriers  and  recipients  is  100,  however,
numbers larger than 100 can be used. The default value is 100.

This is an example of an import line that would import a recipient tied to a carrier named Email whose
short name is tech_support, full name is Tech Support, ID to send to is support@notepage.com with
DropControl disabled, SendSubject enabled and also allowing the Sender's Name to prefix messages
sent to this recipient:
"500","tech_support","Tech
Support","support@notepage.com","Email","500",#TRUE#,#FALSE#,#FALSE#,#FALSE#,#FALSE#,#TR
UE#,#FALSE#,"","","100"

5.1.1.1.3  Importing Groups from a Text File

To import a Comma Separated Values text file in to NotePager Pro to add or update Groups, the file
must be formatted very, very specifically.

The specific data structure of each record is as follows:

"Version","Name","FullName","Id","Carrier","MaxChars","Alpha","OnCall","AdHoc","DropControl","Group"
,"SendSubject","RemoveFrom","Extra1","Extra2","Priority"

Field Description and Values

Version
This  field declares  the version of the import  file  and  should
be set to: 500

Name

This  field  assigns  the  Short  Name  of  the  group  to  be
imported.  Names  should  be  assigned  with  alphanumeric
characters. Special characters such as  ! @ # $ % ^ & * ( )
+ = [ ] { } / ? \ | ;  :  ' "  ,  <  > and spaces are disallowed from



NotePager Pro v5.0 Documentation50

© 2001-2015 NotePage, Inc.

this field. Underscores and dashes can be used.

FullName

This  field  assigns  the  Full  Name  of  the  group  to  be
imported.  Names  should  be  assigned  with  alphanumeric
characters. Special characters such as  ! @ # $ % ^ & * ( )
+ = [  ]  { } /  ?  \  |  ;  :  '  "  <  >  are  disallowed  from  this  field.
Spaces, commas, underscores and dashes can be used.

Id
This  field is  not  used  in  the  Groups  import  and  should  be
set to a blank string value ("").

Carrier
This  field is  not  used  in  the  Groups  import  and  should  be
set to a blank string value ("").

MaxChars This field should have a value of: 1024

Alpha This field should have a value of: #FALSE#

OnCall

For  the  Groups  import,  this  field  determines  whether  the
On-Call property should be enabled.

If this Group should be configured as  an On-Call group,  set
this value to: #TRUE#

If this Group should be NOT configured as an On-Call group,
set this value to: #FALSE#

NOTE: Configuration of the On-Call schedule must  be done
from  within  the  NotePager  Pro  interface  and  cannot  be
configured as part of an import file.

AdHoc This field should have a value of: #FALSE#

DropContr
ol

This field should have a value of: #FALSE#

Group For the Groups import, set this value to: #TRUE#

SendSubje
ct

This field should have a value of: #FALSE#

RemoveFr
om

This field should have a value of: #FALSE#

Extra1
This  field  corresponds  to  the  Comment1  field  within  a
group's settings. If you want  to leave a comment about  this
group, enter it here.

Extra2
This  field  corresponds  to  the  Comment2  field  within  a
group's settings. If you want to leave a secondary  comment
about this group, enter it here.
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Priority

This field value must be set to a value from 1 to 100,  with 1
representing  the  highest  priority.  The  default  value  all
carriers and recipients is 100, however, numbers  larger than
100 can be used. The default value is 100.

This is an example of an import line that would import a group with a short name of priority_one, a full
name of Priority One: 
"500","priority_one","Priority
One","","","1024",#FALSE#,#FALSE#,#FALSE#,#FALSE#,#TRUE#,#FALSE#,#FALSE#,"","","100"

5.1.1.1.4  Importing Group Members from a Text File

To import a Comma Separated Values text file in to NotePager Pro to add or update Group Members,
the file must be formatted very, very specifically.

The specific data structure of each record is as follows:

"Version","Name","FullName","Id","Carrier","MaxChars","Alpha","OnCall","AdHoc","DropControl","Group"
,"SendSubject","RemoveFrom","Extra1","Extra2","Priority"

Field Description and Values

Version
This  field declares  the version of the import  file  and  should
be set to: 500

Group
This  field assigns the group the group  members  should  be
added to and MUST exactly match the short name field of a
group that exists within NotePager Pro.

Recipient
This field assigns the recipient  to add as  a member to  the
group  and  MUST exactly  match  the  short  name  field  of  a
recipient that exists within NotePager Pro.

This is an example of a set of three import lines that would add kirk_hammet, joe_satriani and bb_king
as members of the Masters group: 

"500","kirk_hammet","masters"
"500","joe_satriani","masters"
"500","bb_king","masters"

5.1.1.2 Importing from PageGate

To import from PageGate, you must first have PageGate installed and configured. 

When selecting the "Import from PageGate" option, you will be presented with this screen:
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Put a check in each of the items you wish to import, select whether you want to overwrite or skip
existing records, then specify the path to the PageGate server's database.

If you are uncertain of the location of this database, please contact the PageGate Administrator for your
PageGate server.

5.1.2 Export

The  Export
function
allows  you  to
output
information
from
NotePager
Pro  in  two
different
formats.

NotePager
Pro  can
export to:

PageGate

Text File
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5.1.2.1 Exporting to PageGate

To export data from NotePager Pro in to PageGate, you must first have PageGate installed and
configured. 

When selecting the "Export to PageGate" option, you will be presented with this screen:

Put a check in each of the items you wish to export, select whether you want to overwrite or skip
existing records, then specify the path to the PageGate server's database.

If you are uncertain of the location of this database, please contact the PageGate Administrator for your
PageGate server.

5.1.2.2 Exporting to Text File

The  Export  to  Text  File  function  allows  you  to  take  information  from  NotePager  Pro  and  output  in  a
Comma Separated Values text file.

When selecting the "Export to Text File" option, you will be presented with this screen:
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As shown above, NotePager Pro can export Carriers, Recipients, Groups and Group Members. 

Select the Export you want to perform, then specify the path and file name in the 'File to Export To'
section and click on Apply.

Each export must be performed separately and each exported file will need its own, unique name.

5.1.3 Register

Note: Once you register the program, this menu option will no longer be available.

When selecting the Register menu option, you will be presented with the following screen:

Note: Registration keys for NotePager Pro are case and punctuation sensitive and will need to be
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entered exactly as shown.

5.2 Tools

The Tools
menu for
NotePager Pro
provides the
following
options:

Settings

Check
Spelling

Preset
Messages

Modem
Scan

Port Scan
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5.2.1 Settings

The Settings
sub-menu for
NotePager Pro
provides the
following
options:

General

Connection

Display

Passwords

User/Global

5.2.1.1 General
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Sender's Name

This field specifies who or what the name of the sender should be for non-SMTP
messages. This name will display on the receiving device as who or what sent
the messages from NotePager Pro. By default, this value is set to %LoginName
%, which will use the Windows Username of the user you're currently logged in
to Windows with. 

Note: Special characters and spaces should not be used in this field. 

Sender's Email
When using the SMTP protocol, this field is used in lieu of the Sender's Name
field. This field MUST be a valid email address on the domain or internet service
that the computer running NotePager Pro is connected to.

Max Log Length
This field determines the maximum size of the NotePager Pro log. Anything that
exceeds this length will be purged from the logs.

Purge After
This field determines how long you want to keep the store of messages within
the database. By default, this value is set to 30 days but can be set to a
maximum value of 365 days.

Logging Level

This field can be set to one of three values: Summary, Detail and Debug

For ease of assistance when contacting NotePager Pro Tech Support, this field
should be set to Debug.

Archive Log

If Archive Log is enabled, when the date changes, NotePager Pro will take the
previous day(s) log and rename it to the date on which the program was run,
then create a new log for the new day. For example, if Archive Log is enabled
and you run NotePager Pro on 4/28, then don't run the program again until 4/30,
the program will create an archived log of the transaction history for 4/28 before it
starts a new log for 4/30.

Enable Spell Check
(requires MS Word)

If Microsoft Word is installed, this option enables automatic spell checking for
the NotePager Pro message window.

5.2.1.2 Connection
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Modem Port
This field specifies the COM port NotePager Pro should use for the modem. This
port MUST match the COM port of the Modem. If you are unsure of your
modem's COM port, try using the Modem Scan function in the base Tools Menu.

Dialing Prefix If you must dial a prefix before reaching an outside line, enter that prefix here.

Retries
This field determines the number of times NotePager Pro should attempt to
deliver a message before marking it as failed.

Retry Interval
This field determines how long NotePager Pro should wait in between connection
attempts.

5.2.1.3 Display
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Comment1 Label
Within the settings of Recipients and Groups, there is a field that, by default, is
labeled Comment1. This field allows you to modify that field label.

Comment2 Label
Within the settings of Recipients and Groups, there is a field that, by default, is
labeled Comment2. This field allows you to modify that field label.

Max Msg Length
This field determines the maximum number of characters that can be entered in
to the Message window of the NotePager Pro interface.

Remove Preset
Buttons

Enabling this option will remove the Preset Messages buttons from the bottom of
the NotePager Pro interface.

Remove Schedule
Button

Enabling this option will remove the Scheduling Calendar button from the
NotePager Pro Interface.

Remove Logs Enabling this option will remove the ability to access the View Menu functions. 

Remove Reports
Enabling this option will remove the ability to access the Reports Menu
functions. 

Small Recipient Font
Enabling this option will make the text of the Recipients and Selected
Recipients list smaller.

Failure Warning
Popup

If this option is enabled and a message fails to send, a pop-up warning message
will display.

Clear on Send
If this option is enabled, when the Send button is clicked, the selection in the
Selected Recipients box and the text typed in the Message box will be cleared.

Display Group label
'(G)'

This field specifies whether you want to (G) that signifies that a group will appear
before or after the group's name.

Minimize To
This field specifies whether you want NotePager Pro to minimize to the Task Bar
with the other applications or the System Tray, next to the clock in Windows. It
is recommended that this option be set to 'Task Bar'.

5.2.1.4 Passwords
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5.2.1.5 User/Global

The User/Global sub-menu allows you to specify whether certain settings should apply to all users who
access NotePager Pro or only for the user you're currently logged in to Windows and accessing the
program with.

5.2.2 Check Spelling

After enabling Spell Check, the Check Spelling menu option will check the spelling of any text entered in
to the Message box.

If you do not have Spell Checking enabled, you will receive this message:

To enable Spell Checking, go to the Tools - Settings - General menu and put a check in Enable Spell
Check (requires MS Word), as shown below.
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5.2.3 Preset Messages

The Preset Messages sub-menu allows you to view, modify and delete the preset messages within
NotePager Pro.

Note: After modifying or deleting preset messages, be sure to click on the Apply button to save your
changes. 
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To modify a preset message, click on the Preset you wish to edit, then click the Edit button:

Field Function

Description
This field modifies the text that is displayed on the Preset Messages button on the bottom
of the NotePager Pro interface.

Recipient
(optional)

This field allows you to specify a default Recipient or Group that this preset message
should go to.

Message This field allows you to specify the preset message to be sent.

5.2.4 Modem Scan

The Modem Scan sub-menu provides a way for NotePager Pro to attempt to automatically determine the
COM port of your modem. Any modems present on the scan will display a check mark in the COM port
on which they are assigned.
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5.2.5 Port Scan

The Port Scan sub-menu provides a way for NotePager Pro to attempt to automatically determine the
TCP communication ports are allowed by your network security settings. 

Ports 25, 465 and 587 are for SMTP.

Port 80 is for WCTP.

Port 444 is for SNPP.

If any of these ports fail and you need to use them, please contact your network administrator about
having the port opened.
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5.3 Carriers

A  carrier  is  a
company  that
provides  the
service  for  a
wireless
device  (pager,
phone,  PIM,
etc.).   They
control  the
antennas,
satellites,
broadcast,
and  computer
systems  that
are  used  to
send  the
messages  to
your  cell
phones  and
pagers.  

The  Carriers
menu  for
NotePager
Pro  provides
the  following
options:

Add

Edit

Delete

5.3.1 Adding a Carrier

How to add a FAX carrier

How to add a FAXSRV carrier

How to add a GSMAT carrier

How to add an SMTP carrier

How to add an SNPP carrier

How to add a TAP carrier

How to add a TONE carrier

How to add a UCP carrier
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How to add a WCTP carrier

5.3.1.1 How to add a FAX carrier

The FAX protocol configures this carrier to send facsimile transmissions.

Note: The fax number to dial/send to is configured in the Recipients section.

1) Select the FAX protocol.

2) Give the Carrier a name.
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3) Click on the Advanced button.

4) Select the Fax Class. This must match at least one of the supported fax classes of your fax modem
and the receiving fax machine. For more information on Fax Classes, click here.

5) If you are familiar with the AT command set of your modem and know the proper initialization string to
use, enter it in to the Init String field or select it from the dropdown list. Otherwise, leave this field set
to (auto).

6) The Max Chars value determines the maximum number of characters that can be transmitted in a

http://en.wikipedia.org/wiki/Fax#Class
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single fax.

7) Set the Priority of the carrier. This can be set to a value from 1 to 100, with 1 representing the highest
priority. The default value all carriers and recipients is 100, however, numbers larger than 100 can be
used.

8) Click on Back.

9) Click on Apply.

10)Click on OK.

5.3.1.2 How to add a FAXSRV carrier

The FAXSRV protocol configures this carrier to pass fax transmissions to a local Microsoft Fax Server. 

Note: The fax number to dial/send to is configured in the Recipients section.

1) Select the FAXSRV protocol.
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2) Give the Carrier a name.

3) Click on the Advanced button.
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4) The Max Chars value determines the maximum number of characters that can be transmitted in a
single fax.

5) Set the Priority of the carrier. This can be set to a value from 1 to 100, with 1 representing the highest
priority. The default value all carriers and recipients is 100, however, numbers larger than 100 can be
used.

6) Click on Back.

7) Click on Apply.
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8) Click on OK.

5.3.1.3 How to add a GSMAT carrier

The GSMAT protocol configures this carrier to use a Cellular Modem to transmit SMS messages.

Note: Be sure to set the COM port of the device in the Connection Settings.

1) Select the GSMAT protocol.

2) Give the Carrier a name.
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3) Click on the Advanced button.

4) Specify the Baud Rate, Parity, Data Bits and Stop Bits for your cellular modem. The industry standard
for most cellular modems are the defaults shown above (115200, NONE, 8, 1)

5) Click inside the Init String field and enter: AT+CSQ.



NotePager Pro v5.0 Documentation72

© 2001-2015 NotePage, Inc.

6) Leave the Max Chars value at 160.

7) The Msg Limit specifies how many messages should be sent in a single session with the cellular
modem before NotePager Pro disconnects from the modem, then reconnects to send any remaining
messages. Some cellular modems require that each message be sent in its own session, so if you
have one of those cellular modems, set the Msg Limit to 1. If you are unsure of the Message Limit of
your cellular modem, please contact the device's manufacturer.

8) Set the Priority of the carrier. This can be set to a value from 1 to 100, with 1 representing the highest
priority. The default value all carriers and recipients is 100, however, numbers larger than 100 can be
used.

9) Click on Back.
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10) Click on Apply.

11) Click on OK.

5.3.1.4 How to add an SMTP carrier

SMTP configurations vary from network to network. Some networks allow direct SMTP over port 25,
others require that you relay your messages through a mail server.

To determine which variety of SMTP is available to you, there is a connection test you'll need to run that
requires the Telnet Client to be enabled in Windows.

If you use Windows XP or Server 2003, the Telnet Client is enabled by default. If you use Windows Vista,
7, 8/8.1, Server 2008 or Server 2012, you will need to enable the Telnet Client.

For information on how to enable the Telnet Client in Windows Vista, 7 or Windows 8/8.1, click here.

For information how to enable the Telnet Client in Server 2008 or Server 2012, click here.

After the telnet client has been enabled, this is the port test you'll want to run:



NotePager Pro v5.0 Documentation74

© 2001-2015 NotePage, Inc.

1) In Windows, run a Command Prompt.

2) In the Command Prompt, type the following and hit enter:

telnet smtp-bb.vtext.com 25

If port 25 is open and there are no outstanding issues with the public IP address the system sits behind,
you'll receive a 220 response. 
If you receive a 220 response, use the Adding a direct SMTP Carrier steps.

If port 25 is open but there is an outstanding issue with the public IP the system sits behind, you'll
receive a 554 or a 421 rejection notice. 
This indicates that your public IP is on a blacklist, so you will need to determine which blacklists you're
on. To do that, from the computer running the software, go to www.whatismyipaddress.com and get your
public IP. Then click on the Blacklist Check option at the top of the page and run the test. Any list that
has a red ! next to it is a list the IP address is on, so you'll want to go to each of those links and go
through their provided lookup and removal steps. Once your IP is off of those blacklists, you can use
direct SMTP from that system.

If port 25 isn't open at all, you'll receive a response that says "Unable to establish a connection to the
host on port 25".

If port 25 isn't open, you may be able to have it opened but you will need to speak with your network
administrator or internet service provider's tech support.

If port 25 is closed and cannot be opened, you must relay your traffic through an SMTP server and you
will need to contact your local IT staff or internet service provider's tech support and ask them the
following questions:

1) What SMTP Server can you use?

2) What port should you connect to that server on?

3) Does that server require authentication?

3a) If the server does require authentication, what styles of authentication are supported and what
username and password should you use to authenticate with?

Once you have the answers to those questions, use the Adding a relayed SMTP Carrier steps.

5.3.1.4.1  Enabling the Telnet Client in Window s Vista, 7 and 8/8.1

1) In Windows, open the Control Panel.

2) In the upper right hand portion of the Control Panel, set "View by"  to Small Icons.

3) In the Control Panel, open Programs and Features.

4) On the left hand side, click on "Turn Windows Features on/off"

5) Put a check next to Telnet Client.

6) Click on OK.

http://www.whatismyipaddress.com
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5.3.1.4.2  Enabling the Telnet Client in Window s Server 2008 or 2012

1) In Windows, open the Server Manager.

2) On the left hand side, click on Features.

3) On the right hand side, click on Add Feature.

4) In the Features list, put a check next to Telnet Client.

5) Click on Next.

6) Click on Install.

5.3.1.4.3  Adding a direct SMTP Carrier

1) Select the SMTP protocol.

2) Give the Carrier a name.
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3) Leave the Port set to: 25

4) In the Domain field, enter your network's Email Domain. If you are unsure what your email domain is,
please contact your network administrator.

5) Select "Deliver directly to destination server".

6) Click the Advanced button.
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7) Leave the Max Chars value at: 160

8) Set the Priority of the carrier. This can be set to a value from 1 to 100, with 1 representing the highest
priority. The default value all carriers and recipients is 100, however, numbers larger than 100 can be
used.

9) Click on Back.

10) Click on Apply.
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11) Click on OK.

5.3.1.4.4  Adding a relayed SMTP Carrier

1) Select the SMTP protocol.

2) Give the Carrier a name.
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3) Select the port and handshaking method required by your SMTP server. If you are unsure of the port or
handshaking method, please contact your SMTP server administrator or ISP's tech support.

4) In the Domain field, enter the Email Domain of the SMTP server you are sending through. If you are
unsure what email domain to use, please contact your SMTP server administrator or ISP's tech
support.
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5) Select "Deliver through local/ISP mail server" and enter the SMTP server address in the Relay Server
field.

6) Click the Advanced button.
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7) Leave the Max Chars value at: 160

8) Set the Priority of the carrier. This can be set to a value from 1 to 100, with 1 representing the highest
priority. The default value all carriers and recipients is 100, however, numbers larger than 100 can be
used.

9) Select the Authentication Type that your mail server requires. For most mail servers, you'll want to
select 'Standard'. If you are unsure what authentication type to use, please contact your SMTP server
administrator or ISP's tech support.
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10) Enter the authentication credentials (username and password) required by your mail server. If you are
unsure what authentication credentials to use, please contact your SMTP server administrator or ISP's
tech support.

11)Click on Back.

12) Click on Apply.
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13) Click on OK.

5.3.1.5 How to add an SNPP carrier

The SNPP protocol configures this carrier to use your internet connection to send messages to a
carrier's Simple Network Paging Protocol host.

1) Select the SNPP protocol.

2) Give the Carrier a name.
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3) In the Host field, enter the SNPP host to connect to. For a list of SNPP host addresses, please see
our support site.

4) Click the Advanced button.

http://www.notepage.net/snpp.htm
http://www.notepage.net/snpp.htm
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5) Port 444 is the standard SNPP port. If the SNPP host you need to connect to uses non-standard port,
enter it here.

6)  Leave the Max Chars value at: 160

7) The Msg Limit specifies how many messages should be sent in a single session before NotePager
Pro disconnects from the host, then reconnects to send any remaining messages. Some hosts have a
message limit, some don't. If you are unsure of the Message Limit of your SNPP host, please contact
the SNPP host provider.

8) Set the Priority of the carrier. This can be set to a value from 1 to 100, with 1 representing the highest
priority. The default value all carriers and recipients is 100, however, numbers larger than 100 can be
used.

9) If the SNPP host you need to connect to requires authentication, select Standard from the Auth Type
dropdown list and enter the required authentication credentials. If you are unsure of the authentication
requirements or credentials, please contact the SNPP host provider.
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10)Click on Back.

11) Click on Apply.
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12) Click on OK.

5.3.1.6 How to add a TAP carrier

The TAP protocol configures this carrier to use a dial-up modem to transmit messages.

Note: Be sure to set the COM port of the device in the Connection Settings.

1) Select the TAP protocol.

2) Give the Carrier a name.
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3) Enter the TAP terminal phone number of the destination carrier. For a list of known TAP terminals, 
please visit the support section of our website.

4) Click on the Advanced button.

http://www.notepage.net/tap-phone-numbers.htm
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5) Specify the Baud Rate, Parity, Data Bits and Stop Bits required by the receiving TAP system. The
industry standard for most TAP terminals are the defaults shown above (1200, EVEN, 7, 1)

6) If you are familiar with the AT command set of your modem and know the proper initialization string to
use, enter it in to the Init String field or select it from the dropdown list. Otherwise, leave this field set
to (auto).

7) Leave the Max Chars value at 160.

8) The Msg Limit specifies how many messages should be sent in a single session before NotePager
Pro disconnects from the receiving TAP system, then reconnects to send any remaining messages.

9) Set the Priority of the carrier. This can be set to a value from 1 to 100, with 1 representing the highest
priority. The default value all carriers and recipients is 100, however, numbers larger than 100 can be
used.

10) If the TAP system you are connecting to requires authentication, select Standard from the Auth Type
dropdown list and enter the required authentication credentials in the password field.
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11)Click on Back.

12) Click on Apply.
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13) Click on OK.

5.3.1.7 How to add a TONE carrier

The TONE protocol configures this carrier to use a dial-up modem to call a phone number and transmit a
series of touch tones.

Note: Be sure to set the COM port of the device in the Connection Settings.

1) Select the TONE protocol.

2) Give the Carrier a name.
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3) Click on the Advanced button.

4) If you are familiar with the AT command set of your modem and know the proper initialization string to
use, enter it in to the Init String field or select it from the dropdown list. Otherwise, leave this field set
to (auto).

5) Leave the Max Chars value at 10.

6) Set the Priority of the carrier. This can be set to a value from 1 to 100, with 1 representing the highest
priority. The default value all carriers and recipients is 100, however, numbers larger than 100 can be
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used.

7) The Wait String field determines how long NotePager Pro should wait before transmitting the TONE
characters. Each comma represents a 2 second delay.

8) Click on Back.

9)  Click on Apply.

10) Click on OK.

5.3.1.8 How to add a UCP carrier

The UCP protocol configures this carrier to use a dial-up modem to transmit messages.

Note: Be sure to set the COM port of the device in the Connection Settings.

1) Select the UCP protocol.
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2) Give the Carrier a name.

3) Enter the UCP terminal phone number of the destination carrier. 
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4) Click on the Advanced button.

5) Specify the Baud Rate, Parity, Data Bits and Stop Bits required by the receiving UCP system. 

6) If you are familiar with the AT command set of your modem and know the proper initialization string to
use, enter it in to the Init String field or select it from the dropdown list. Otherwise, leave this field set
to (auto).

7) Leave the Max Chars value at 160.
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8) The Msg Limit specifies how many messages should be sent in a single session before NotePager
Pro disconnects from the receiving UCP system, then reconnects to send any remaining messages. 

9) Set the Priority of the carrier. This can be set to a value from 1 to 100, with 1 representing the highest
priority. The default value all carriers and recipients is 100, however, numbers larger than 100 can be
used.

10) If the UCP system you are connecting to requires authentication, select Standard from the Auth Type
dropdown list and enter the required authentication credentials in the password field.

11)Click on Back.
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12) Click on Apply.

13) Click on OK.

5.3.1.9 How to add a WCTP carrier

The WCTP protocol configures this carrier to use your internet connection to send messages to a
carrier's Wireless Communication Transfer Protocol host.

1) Select the WCTP protocol.
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2) Give the Carrier a name.

3) In the Host field, enter the WCTP host to connect to. For a list of WCTP host addresses, please see
our support site.

http://www.notepage.net/wctp.htm
http://www.notepage.net/wctp.htm
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4) Click the Advanced button.

5) If you are connecting to the WCTP host as a transient client (this is the most common method of
delivery), select Transient Client. If the WCTP host you are connecting to is an Enterprise host, which
is less common, select Enterprise Host.

6) Port 80 is the standard WCTP port. If the WCTP host you need to connect to uses non-standard port,
enter it here.

7)  Leave the Max Chars value at: 160
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8) Set the Priority of the carrier. This can be set to a value from 1 to 100, with 1 representing the highest
priority. The default value all carriers and recipients is 100, however, numbers larger than 100 can be
used.

9) If the WCTP host you need to connect to requires authentication, select the required method from the
Auth Type dropdown list and enter the required authentication credentials in the Password field. If you
are unsure of the authentication type or credentials, please contact the WCTP host provider.

10)Click on Back.
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11) Click on Apply.

12) Click on OK.

5.3.2 Editing a Carrier

The Edit Carrier menu provides a method of modifying a carrier's settings and provides list of all carriers
currently configured in the program.

To edit a carrier, simply click on the name in the list, then click on Edit.

5.3.3 Deleting a Carrier

The Delete Carrier menu provides a method of removing a carrier from the program and provides list of all
carriers currently configured in the program.
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To delete a carrier, simply click on the name in the list, then click on Delete.

NOTE: A carrier cannot be deleted if there are recipients tied to it. For information on how to delete a
recipient, please click here.

5.4 Recipients

A recipient is a
person or
system whose
cell phone,
pager or email
address you
want to
message.

The Recipients
menu for
NotePager Pro
provides the
following
options:

Add

Edit

Delete
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5.4.1 Adding a Recipient

When adding a Recipient in to NotePager Pro, you will need to select a Carrier for the Recipient.

The protocol of the Carrier will determine how the Recipient needs to be configured.

Adding a Recipient to a FAX Carrier

Adding a Recipient to a FAXSRV Carrier

Adding a Recipient to a GSMAT Carrier

Adding a Recipient to a SMTP Carrier

Adding a Recipient to a SNPP Carrier

Adding a Recipient to a TAP Carrier

Adding a Recipient to a TONE Carrier

Adding a Recipient to a UCP Carrier

Adding a Recipient to a WCTP Carrier

5.4.1.1 Adding a Recipient to a FAX Carrier

Note: You must have a carrier configured to use the FAX protocol. For steps on how to configure a FAX
carrier, please see the "How to add a FAX carrier" section.

1) Enter a Full Name for the recipient.

2) Click inside the Short Name field to have the program automatically fill in the field.
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3) From the Carrier dropdown list, select the carrier you have configured to use the FAX protocol.

4) Enter the phone number of the fax machine.

5) Click the Advanced button.
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6) Leave the Type as: Normal

7) If you wish to leave a note about this recipient, enter it in the Comment1 or Comment 2 fields.

8) The Max Chars field in the Recipient Settings determines the maximum number of characters you
wish to send to this recipient. If this value is set higher than the Carrier Max Chars value, NotePager
Pro will split long messages into multiple messages.

9) Set the Priority of the carrier. This can be set to a value from 1 to 100, with 1 representing the highest
priority and 100 representing the lowest priority. The default value all carriers and recipients is: 100

10) If you are using a template that specifies a subject line, "Extract Subject" will collect the subject
from the message text and pass it as the Subject line of the facsimile transmission.

11) Click on Back.
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12) Click on Apply.

13) Click on OK.

5.4.1.2 Adding a Recipient to a FAXSRV Carrier

Note: You must have a carrier configured to use the FAXSRV protocol. For steps on how to configure a
FAXSRV carrier, please see the "How to add a FAXSRV carrier" section.

1) Enter a Full Name for the recipient.
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2) Click inside the Short Name field to have the program automatically fill in the field.

3) From the Carrier dropdown list, select the carrier you have configured to use the FAXSRV protocol.

4) Enter the phone number of the fax machine.
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5) Click the Advanced button.

6) Leave the Type as: Normal

7) If you wish to leave a note about this recipient, enter it in the Comment1 or Comment 2 fields.

8) The Max Chars field in the Recipient Settings determines the maximum number of characters you
wish to send to this recipient. If this value is set higher than the Carrier Max Chars value, NotePager
Pro will split long messages into multiple messages.

9) Set the Priority of the carrier. This can be set to a value from 1 to 100, with 1 representing the highest
priority and 100 representing the lowest priority. The default value all carriers and recipients is: 100
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10) If you are using a template that specifies a subject line, "Extract Subject" will collect the subject
from the message text and pass it as the Subject line of the facsimile transmission.

11) Click on Back.

12) Click on Apply.

13) Click on OK.

5.4.1.3 Adding a Recipient to a GSMAT Carrier

Note: You must have a carrier configured to use the GMSAT protocol. For steps on how to configure a
GSMAT carrier, please see the "How to add a GSMAT carrier" section.

1) Enter a Full Name for the recipient.
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2) Click inside the Short Name field to have the program automatically fill in the field.

3) From the Carrier dropdown list, select the carrier you have configured to use the GSMAT protocol.

4) Enter the cell phone number of the recipient, including the area code, with no spaces or dashes.
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5) Click the Advanced button.

6) Leave the Type as: Normal

7) If you wish to leave a note about this recipient, enter it in the Comment1 or Comment 2 fields.

8) The Max Chars field in the Recipient Settings determines the maximum number of characters you
wish to send to this recipient. If this value is set higher than the Carrier Max Chars value, NotePager
Pro will split long messages into multiple messages.

9) Set the Priority of the carrier. This can be set to a value from 1 to 100, with 1 representing the highest
priority and 100 representing the lowest priority. The default value all carriers and recipients is: 100
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10) If the device you are sending to can receive both alpha and numeric characters, leave Alpha checked.
If the device you are sending to can only receive numeric characters, uncheck Alpha.

11) Non-printable characters are things like carriage returns, line feeds, horizontal tabs and the like. If
you do not want these characters to appear in messages sent to this recipient, leave 'Strip non-
printable characters' checked. If you do want these characters to appear in messages sent to this
recipient, uncheck 'Strip non-printable characters'. 

12) If 'Strip sender's name' is checked, NotePager pro will not prefix your messages with the sender's
name.

13) Click on Back.

14) Click on Apply.

15) Click on OK.

5.4.1.4 Adding a Recipient to an SMTP Carrier

Note: You must have a carrier configured to use the SMTP protocol. For steps on how to configure a
SMTP carrier, please see the "How to add an SMTP carrier" section.
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1) Enter a Full Name for the recipient.

2) Click inside the Short Name field to have the program automatically fill in the field.

3) From the Carrier dropdown list, select the carrier you have configured to use the SMTP protocol.

4) In the ID/PIN field, either enter the email address of this recipient or enter the contact address of their
cell phone. For a list carrier contact addresses, please see our support site. 

http://www.notepage.net/smtp.htm
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5) Click the Advanced button.

6) Leave the Type as: Normal

7) If you wish to leave a note about this recipient, enter it in the Comment1 or Comment 2 fields.

8) The Max Chars field in the Recipient Settings determines the maximum number of characters you
wish to send to this recipient. If this value is set higher than the Carrier Max Chars value, NotePager
Pro will split long messages into multiple messages.

9) Set the Priority of the carrier. This can be set to a value from 1 to 100, with 1 representing the highest
priority and 100 representing the lowest priority. The default value all carriers and recipients is: 100
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10) If the device you are sending to can receive both alpha and numeric characters, leave Alpha checked.
If the device you are sending to can only receive numeric characters, uncheck Alpha.

11) Non-printable characters are things like carriage returns, line feeds, horizontal tabs and the like. If
you do not want these characters to appear in messages sent to this recipient, uncheck 'Strip non-
printable characters'. If you do not want these characters to appear in messages sent to this recipient,
uncheck 'Strip non-printable characters'. 

12) If 'Strip sender's name' is checked, NotePager pro will not prefix your messages with the sender's
name.

13) If 'Extract Subject' is checked, NotePager Pro will look within the first 40 characters of your message
for a carriage return. If it finds one, everything before the carriage return will be used as the Subject
and will not appear in the body of the message. If 'Extract Subject' is unchecked, NotePager Pro will
not look for a subject within the message and will instead use the default subject line of 'TEXT
MESSAGE'.

14) Click on Back.

15) Click on Apply.

16) Click on OK.
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5.4.1.5 Adding a Recipient to an SNPP Carrier

Note: You must have a carrier configured to use the SNPP protocol. For steps on how to configure a
SNPP carrier, please see the "How to add an SNPP carrier" section.

1) Enter a Full Name for the recipient.

2) Click inside the Short Name field to have the program automatically fill in the field.

3) From the Carrier dropdown list, select the carrier you have configured to use the SNPP protocol.



The Menus 117

© 2001-2015 NotePage, Inc.

4) Enter the pager or cell phone number with no spaces or dashes.

5) Click the Advanced button.

6) Leave the Type as: Normal

7) If you wish to leave a note about this recipient, enter it in the Comment1 or Comment 2 fields.

8) The Max Chars field in the Recipient Settings determines the maximum number of characters you
wish to send to this recipient. If this value is set higher than the Carrier Max Chars value, NotePager
Pro will split long messages into multiple messages.

9) Set the Priority of the carrier. This can be set to a value from 1 to 100, with 1 representing the highest
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priority and 100 representing the lowest priority. The default value all carriers and recipients is: 100

10) If the device you are sending to can receive both alpha and numeric characters, leave Alpha checked.
If the device you are sending to can only receive numeric characters, uncheck Alpha.

11) Non-printable characters are things like carriage returns, line feeds, horizontal tabs and the like. If
you do not want these characters to appear in messages sent to this recipient, leave 'Strip non-
printable characters' checked. If you do want these characters to appear in messages sent to this
recipient, uncheck 'Strip non-printable characters'. 

12) If 'Strip sender's name' is checked, NotePager pro will not prefix your messages with the sender's
name.

13) Click on Back.

14) Click on Apply.

15) Click on OK.

5.4.1.6 Adding a Recipient to a TAP Carrier

Note: You must have a carrier configured to use the TAP protocol. For steps on how to configure a TAP
carrier, please see the "How to add a TAP carrier" section.
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1) Enter a Full Name for the recipient.

2) Click inside the Short Name field to have the program automatically fill in the field.

3) From the Carrier dropdown list, select the carrier you have configured to use the TAP protocol.

4) In the ID/PIN field, enter the cell phone or pager number with no spaces or dashes.
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5) Click the Advanced button.

6) Leave the Type as: Normal

7) If you wish to leave a note about this recipient, enter it in the Comment1 or Comment 2 fields.

8) The Max Chars field in the Recipient Settings determines the maximum number of characters you
wish to send to this recipient. If this value is set higher than the Carrier Max Chars value, NotePager
Pro will split long messages into multiple messages.

9) Set the Priority of the carrier. This can be set to a value from 1 to 100, with 1 representing the highest
priority and 100 representing the lowest priority. The default value all carriers and recipients is: 100
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10) If the device you are sending to can receive both alpha and numeric characters, leave Alpha checked.
If the device you are sending to can only receive numeric characters, uncheck Alpha.

11) Non-printable characters are things like carriage returns, line feeds, horizontal tabs and the like. If
you do not want these characters to appear in messages sent to this recipient, leave 'Strip non-
printable characters' checked. If you do want these characters to appear in messages sent to this
recipient, uncheck 'Strip non-printable characters'. 

12) If 'Strip sender's name' is checked, NotePager pro will not prefix your messages with the sender's
name.

13) Click on Back.

14) Click on Apply.

15) Click on OK.

5.4.1.7 Adding a Recipient to a TONE Carrier

Note: You must have a carrier configured to use the TONE protocol. For steps on how to configure a
TONE carrier, please see the "How to add a TONE carrier" section.

1) Enter a Full Name for the recipient.
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2) Click inside the Short Name field to have the program automatically fill in the field.

3) From the Carrier dropdown list, select the carrier you have configured to use the TONE protocol.

4) Enter the phone number you want the touch tones transmitted to.
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5) Click the Advanced button.

6) Leave the Type as: Normal

7) If you wish to leave a note about this recipient, enter it in the Comment1 or Comment 2 fields.

8) The Max Chars field in the Recipient Settings determines the maximum number of characters you
wish to send to this recipient. If this value is set higher than the Carrier Max Chars value, NotePager
Pro will split long messages into multiple messages.

9) Set the Priority of the carrier. This can be set to a value from 1 to 100, with 1 representing the highest
priority and 100 representing the lowest priority. The default value all carriers and recipients is: 100
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10) If 'Strip sender's name' is checked, NotePager pro will not prefix your messages with the sender's
name.

11) Click on Back.

12) Click on Apply.

13) Click on OK.

5.4.1.8 Adding a Recipient to a UCP Carrier

Note: You must have a carrier configured to use the UCP protocol. For steps on how to configure a UCP
carrier, please see the "How to add a UCP carrier" section.

1) Enter a Full Name for the recipient.
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2) Click inside the Short Name field to have the program automatically fill in the field.

3) From the Carrier dropdown list, select the carrier you have configured to use the UCP protocol.

4) In the ID/PIN field, enter the cell phone or pager number with no spaces or dashes.
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5) Click the Advanced button.

6) Leave the Type as: Normal

7) If you wish to leave a note about this recipient, enter it in the Comment1 or Comment 2 fields.

8) The Max Chars field in the Recipient Settings determines the maximum number of characters you
wish to send to this recipient. If this value is set higher than the Carrier Max Chars value, NotePager
Pro will split long messages into multiple messages.

9) Set the Priority of the carrier. This can be set to a value from 1 to 100, with 1 representing the highest
priority and 100 representing the lowest priority. The default value all carriers and recipients is: 100
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10) If the device you are sending to can receive both alpha and numeric characters, leave Alpha checked.
If the device you are sending to can only receive numeric characters, uncheck Alpha.

11) Non-printable characters are things like carriage returns, line feeds, horizontal tabs and the like. If
you do not want these characters to appear in messages sent to this recipient, leave 'Strip non-
printable characters' checked. If you do want these characters to appear in messages sent to this
recipient, uncheck 'Strip non-printable characters'. 

12) If 'Strip sender's name' is checked, NotePager pro will not prefix your messages with the sender's
name.

13) Click on Back.

14) Click on Apply.

15) Click on OK.

5.4.1.9 Adding a Recipient to a WCTP Carrier

Note: You must have a carrier configured to use the WCTP protocol. For steps on how to configure a
WCTP carrier, please see the "How to add a WCTP carrier" section.

1) Enter a Full Name for the recipient.
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2) Click inside the Short Name field to have the program automatically fill in the field.

3) From the Carrier dropdown list, select the carrier you have configured to use the SNPP protocol.

4) Enter the pager or cell phone number with no spaces or dashes.
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5) Click the Advanced button.

6) Leave the Type as: Normal

7) If you wish to leave a note about this recipient, enter it in the Comment1 or Comment 2 fields.

8) The Max Chars field in the Recipient Settings determines the maximum number of characters you
wish to send to this recipient. If this value is set higher than the Carrier Max Chars value, NotePager
Pro will split long messages into multiple messages.

9) Set the Priority of the carrier. This can be set to a value from 1 to 100, with 1 representing the highest
priority and 100 representing the lowest priority. The default value all carriers and recipients is: 100
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10) If the device you are sending to can receive both alpha and numeric characters, leave Alpha checked.
If the device you are sending to can only receive numeric characters, uncheck Alpha.

11) Non-printable characters are things like carriage returns, line feeds, horizontal tabs and the like. If
you do not want these characters to appear in messages sent to this recipient, leave 'Strip non-
printable characters' checked. If you do want these characters to appear in messages sent to this
recipient, uncheck 'Strip non-printable characters'. 

12) If 'Strip sender's name' is checked, NotePager pro will not prefix your messages with the sender's
name.

13) Click on Back.

14) Click on Apply.

15) Click on OK.

5.4.2 Editing a Recipient

The Edit Recipient menu provides a method of modifying a recipient's settings and provides list of all
recipients currently configured in the program.



The Menus 131

© 2001-2015 NotePage, Inc.

To edit a recipient, simply click on the name in the list, then click on Edit.

5.4.3 Deleting a Recipient

The Delete Recipient menu provides a method of removing a recipient and provides list of all recipients
currently configured in the program.

To delete a recipient, simply click on the name in the list, then click on Delete.
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5.5 Groups

A group is a
collection of
recipients.

The Groups
menu for
NotePager Pro
provides the
following
options:

Add

Edit

Delete

Members

5.5.1 Adding a Group

1) Enter a Description for the Group.

2) Click inside the Short Name field to have the program automatically fill in the field.
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3) If you wish to leave a note about this Group, enter it in the Comment1 or Comment 2 fields.

4) If this Group needs to be configured as an On-Call Group, put a check in On-Call group. For
information on configuring the On-Call Schedule, please click here.

5) Click on Apply.

Note: For information on how to add recipients to a group or modify a group's member list, please click
here.

5.5.2 Editing a Group

The Edit Group menu provides a method of modifying a group's settings, including the On-Call Schedule,
and provides list of all groups currently configured in the program.
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To edit a group, simply click on the name in the list, then click on Edit.

5.5.3 Deleting a Group

The Delete Group menu provides a method of removing a group and provides list of all groups currently
configured in the program.

To delete a group, simply click on the name in the list, then click on Delete.
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5.5.4 Modifying Group Members

1) Highlight a Group.

2) Click on Edit.

3) To add a recipient to the Members section, click on the name of the recipient in the Non-members
section. 



NotePager Pro v5.0 Documentation136

© 2001-2015 NotePage, Inc.

4) To remove a Member from the Members section, click on the name of the recipient.

5) When finished, click on Apply.
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6) Click on Close.

5.5.5 On-Call Scheduling

1) In the settings of a Group, put a check in On-Call Schedule.

2) Click on the On-Call Schedule button.
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3) To add a new entry, click on Add.

4) Select a recipient from the Recipient drop down list.
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5) Specify the On-Call Schedule.

6) Click on Apply.
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7) Click on Apply.

5.6 View

The View
menu for
NotePager Pro
provides the
following
options:

Scheduled

Pending

Sent

Bad

History

Activity Log

Activity
Monitor
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5.6.1 Scheduled Messages

The View - Scheduled menu option shows a list of all scheduled and repeating messages. For
information on how to create a scheduled or repeating message, please see the "How to Schedule
Messages" section of the documentation.

Button Function

Refresh
This button will refresh the list of scheduled messages to show you the most recent
information possible.

Details
After highlighting a scheduled message, this button will show the full technical details of the
message.

Cancel After highlighting a scheduled message, this button will remove the highlighted message.

Edit
After highlighting a scheduled message, this button will allow you to edit the recipients or
groups, schedule and content of the scheduled message.

Copy
After highlighting a scheduled message, this button will copy the recipients, content of
message and schedule to the main NotePager Pro interface so you can use it as a template to
create further scheduled messages based on the one copied.

Close This button will close the Scheduled Messages window.

5.6.2 Pending Messages

The View - Pending menu option shows a list of all messages currently in the queue to be delivered. For
information on how to send a message, please see the "How to Send Messages" section of the
documentation.
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Button Function

Refresh
This button will refresh the list of pending messages to show you the most recent information
possible.

Details
After highlighting a pending message, this button will show the full technical details of the
message.

Cancel
After highlighting a pending message, this button will remove the highlighted message from the
queue.

Copy
After highlighting a pending message, this button will copy the recipients and content of the
message to the main NotePager Pro interface so you can use it as a template to create further
messages based on the one copied.

Close This button will close the Pending Messages window.

5.6.3 Sent Messages

The View - Sent menu option shows a list of all messages that have been delivered successfully. 
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Button Function

Refresh
This button will refresh the list of sent messages to show you the most recent information
possible.

Details
After highlighting a sent message, this button will show the full technical details of the
message.

Requeu
e

After highlighting a sent message, this button will re-queue the highlighted message to be sent
again.

Copy
After highlighting a sent message, this button will copy the recipients and content of the
message to the main NotePager Pro interface so you can use it as a template to create further
messages based on the one copied.

Close This button will close the Sent Messages window.

5.6.4 Bad Messages

The View - Bad menu option shows a list of all messages that were not delivered successfully. 

Button Function

Refresh
This button will refresh the list of failed messages to show you the most recent information
possible.

Details
After highlighting a failed message, this button will show the full technical details of the
message.

Requeu
e

After highlighting a failed message, this button will re-queue the highlighted message to be
sent again.

Copy
After highlighting a failed message, this button will copy the recipients and content of the
message to the main NotePager Pro interface so you can use it as a template to create further
messages based on the one copied.

Close This button will close the Bad Messages window.

5.6.5 History

The View - History menu option shows a list of all messages that the program has within its message
store. By default, NotePager Pro will keep 30 days worth of messages in the database. To modify that
value, please see the General Settings section of the documentation.
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Button Function

Print This button will print the message history.

Details After highlighting a message, this button will show the full technical details of the message.

Clipboa
rd

This button will copy the message history to the windows clipboard so you can paste it in to
another window, such as MS Word, Notepad, Wordpad, the body of an email, etc.

Requeu
e

After highlighting a message, this button will re-queue the highlighted message to be sent
again.

Copy
After highlighting a message, this button will copy the recipients and content of the message
to the main NotePager Pro interface so you can use it as a template to create further
messages based on the one copied.

Find
This button will provide a search window that will find the entered text within the message
history.

Close This button will close the Message History window.

5.6.6 Activity Log

The View - Activity Log menu option displays the log of all activity performed with NotePager Pro. By
default, NotePager Pro will keep 1MB worth of information in the log. To modify that value, please see
the General Settings section of the documentation.
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Button Function

Refresh This button will refresh the activity log to show you the most recent information possible.

Print This button will print the activity log.

Purge This button will purge all information from the activity log.

Clipboa
rd

This button will copy the activity log to the windows clipboard so you can paste it in to another
window, such as MS Word, Notepad, Wordpad, the body of an email, etc.

Find This button will provide a search window that will find the entered text within the activity log.

Close This button will close the activity log.

5.6.7 Activity Monitor

The Activity Monitor is a real-time logging window that will appear beside the main NotePager Pro
interface. This window will display what is being logged in the Activity Log as it is happening.
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5.7 Reports

The
Reports
menu for
NotePager
Pro
provides
the ability 
to run four
types of
reports:

Sent
Messag
es

Schedul
ed
Messag
es

Statistic
s

Lists

5.7.1 Sent Messages

There are three types of Sent Message reports that
you can run:

by Recipient

by Date/Time

by Carrier
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5.7.1.1 Sent Messages by Recipient
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Section Function

Recipient(s)
This section provides a list of all recipients and groups within the program. To run
a report on a recipient or group, highlight their name in the list.

Start Date/Time This section specifies the date and time of the beginning of the report.

End Date/Time This section specifies the date and time of the end of the report.

Summary This option will provide a basic summary for messages found by this report.

Details
This option will provide the full technical information for messages found by this
report.

Totals Only This option will provide a numeric total of messages found by this report.

All Msgs
This option specifies that the report should search for all messages, both failed
and delivered.

Good Msgs This option specifies that the report should only search for delivered messages.

Bad Msgs This option specifies that the report should only search for failed messages.

Print Report
(Preview Optional)

With 'Preview' checked, the report will output to a screen for review. With 'Preview'
unchecked, the report will be sent to the selected printer.

Zero Values This option specifies that the report should include zero value results.

Page breaks This option specifies that you do want page breaks to appear in the report.

Write report to file
This option specifies that the report should be written to a file instead of being sent
to a printer.

Email/Fax report to
recipient

If configured, this option allows you to email or fax a report to a recipient within the
Recipients list.

Close This button will close the report window.

Apply This button will run the report.
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5.7.1.2 Sent Messages by Date/Time
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Section Function

Start Date/Time This section specifies the date and time of the beginning of the report.

End Date/Time This section specifies the date and time of the end of the report.

Summary This option will provide a basic summary for messages found by this report.

Details
This option will provide the full technical information for messages found by this
report.

Totals Only This option will provide a numeric total of messages found by this report.

All Msgs
This option specifies that the report should search for all messages, both failed
and delivered.

Good Msgs This option specifies that the report should only search for delivered messages.

Bad Msgs This option specifies that the report should only search for failed messages.

Print Report
(Preview Optional)

With 'Preview' checked, the report will output to a screen for review. With 'Preview'
unchecked, the report will be sent to the selected printer.

Zero Values This option specifies that the report should include zero value results.

Page breaks This option specifies that you do want page breaks to appear in the report.

Write report to file
This option specifies that the report should be written to a file instead of being sent
to a printer.

Email/Fax report to
recipient

If configured, this option allows you to email or fax a report to a recipient within the
Recipients list.

Close This button will close the report window.

Apply This button will run the report.
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5.7.1.3 Sent Messages by Carrier



The Menus 153

© 2001-2015 NotePage, Inc.

Section Function

Carrier(s)
This section provides a list of all carriers within the program. To run a report on a
carrier, highlight its name in the list.

Start Date/Time This section specifies the date and time of the beginning of the report.

End Date/Time This section specifies the date and time of the end of the report.

Summary This option will provide a basic summary for messages found by this report.

Details
This option will provide the full technical information for messages found by this
report.

Totals Only This option will provide a numeric total of messages found by this report.

All Msgs
This option specifies that the report should search for all messages, both failed
and delivered.

Good Msgs This option specifies that the report should only search for delivered messages.

Bad Msgs This option specifies that the report should only search for failed messages.

Print Report
(Preview Optional)

With 'Preview' checked, the report will output to a screen for review. With 'Preview'
unchecked, the report will be sent to the selected printer.

Zero Values This option specifies that the report should include zero value results.

Page breaks This option specifies that you do want page breaks to appear in the report.

Write report to file
This option specifies that the report should be written to a file instead of being sent
to a printer.

Email/Fax report to
recipient

If configured, this option allows you to email or fax a report to a recipient within the
Recipients list.

Close This button will close the report window.

Apply This button will run the report.

5.7.2 Scheduled Messages

There are three types of Scheduled Message
reports that you can run:

by Recipient

by Date/Time

by Carrier
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5.7.2.1 Scheduled Messages by Recipient

Section Function

Print Report
(Preview Optional)

With 'Preview' checked, the report will output to a screen for review. With 'Preview'
unchecked, the report will be sent to the selected printer.

Page breaks This option specifies that you do want page breaks to appear in the report.

Write report to file
This option specifies that the report should be written to a file instead of being sent
to a printer.

Close This button will close the report window.

Apply This button will run the report.

5.7.2.2 Scheduled Messages by Date/Time
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Section Function

Print Report
(Preview Optional)

With 'Preview' checked, the report will output to a screen for review. With 'Preview'
unchecked, the report will be sent to the selected printer.

Write report to file
This option specifies that the report should be written to a file instead of being sent
to a printer.

Close This button will close the report window.

Apply This button will run the report.

5.7.2.3 Scheduled Messages by Carrier

Section Function

Print Report
(Preview Optional)

With 'Preview' checked, the report will output to a screen for review. With 'Preview'
unchecked, the report will be sent to the selected printer.

Page breaks This option specifies that you do want page breaks to appear in the report.

Write report to file
This option specifies that the report should be written to a file instead of being sent
to a printer.

Close This button will close the report window.

Apply This button will run the report.
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5.7.3 Statistics

There are three types of Statistics reports that you
can run:

by Recipient

by Date/Time

by Carrier

5.7.3.1 Statistics by Recipient
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Section Function

Recipient(s)
This section provides a list of all recipients and groups within the program. To run
a report on a recipient or group, highlight their name in the list.

Start Date/Time This section specifies the date and time of the beginning of the report.

End Date/Time This section specifies the date and time of the end of the report.

All Msgs
This option specifies that the report should search for all messages, both failed
and delivered.

Good Msgs This option specifies that the report should only search for delivered messages.

Bad Msgs This option specifies that the report should only search for failed messages.

Print Report
(Preview Optional)

With 'Preview' checked, the report will output to a screen for review. With 'Preview'
unchecked, the report will be sent to the selected printer.

Write report to file
This option specifies that the report should be written to a file instead of being sent
to a printer.

Close This button will close the report window.

Apply This button will run the report.

5.7.3.2 Statistics by Date/Time
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Section Function

Start Date/Time This section specifies the date and time of the beginning of the report.

End Date/Time This section specifies the date and time of the end of the report.

All Msgs
This option specifies that the report should search for all messages, both failed
and delivered.

Good Msgs This option specifies that the report should only search for delivered messages.

Bad Msgs This option specifies that the report should only search for failed messages.

Print Report
(Preview Optional)

With 'Preview' checked, the report will output to a screen for review. With 'Preview'
unchecked, the report will be sent to the selected printer.

Write report to file
This option specifies that the report should be written to a file instead of being sent
to a printer.

Close This button will close the report window.

Apply This button will run the report.

5.7.3.3 Statistics by Carrier
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Section Function

Carrier(s)
This section provides a list of all carriers within the program. To run a report on a
carrier, highlight its name in the list.

Start Date/Time This section specifies the date and time of the beginning of the report.

End Date/Time This section specifies the date and time of the end of the report.

All Msgs
This option specifies that the report should search for all messages, both failed
and delivered.

Good Msgs This option specifies that the report should only search for delivered messages.

Bad Msgs This option specifies that the report should only search for failed messages.

Print Report
(Preview Optional)

With 'Preview' checked, the report will output to a screen for review. With 'Preview'
unchecked, the report will be sent to the selected printer.

Write report to file
This option specifies that the report should be written to a file instead of being sent
to a printer.

Close This button will close the report window.

Apply This button will run the report.

5.7.4 Lists

There are three types of List reports that you can
run:

Recipients

Groups

Carriers
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5.7.4.1 Recipient List Report

Section Function

Recipient(s)
This section provides a list of all recipients within the program. To run a report on a
recipient, highlight their name in the list.

Summary This option will provide a basic summary for recipients found by this report.

Details
This option will provide the full technical information for recipients found by this
report.

Print Report
(Preview Optional)

With 'Preview' checked, the report will output to a screen for review. With 'Preview'
unchecked, the report will be sent to the selected printer.

Write report to file
This option specifies that the report should be written to a file instead of being sent
to a printer.

Close This button will close the report window.

Apply This button will run the report.
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5.7.4.2 Group List Report

Section Function

Group(s)
This section provides a list of all groups within the program. To run a report on a
group, highlight their name in the list.

Summary This option will provide a basic summary for groups found by this report.

Details This option will provide the full technical information for groups found by this report.

Print Report
(Preview Optional)

With 'Preview' checked, the report will output to a screen for review. With 'Preview'
unchecked, the report will be sent to the selected printer.

Members
This option specifies whether you want to see the Members of the Group(s) that
you are running the report on.

Write report to file
This option specifies that the report should be written to a file instead of being sent
to a printer.

Close This button will close the report window.

Apply This button will run the report.
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5.7.4.3 Carrier List Report

Section Function

Group(s)
This section provides a list of all carriers within the program. To run a report on a
group, highlight their name in the list.

Summary This option will provide a basic summary for carriers found by this report.

Details
This option will provide the full technical information for carriers found by this
report.

Print Report
(Preview Optional)

With 'Preview' checked, the report will output to a screen for review. With 'Preview'
unchecked, the report will be sent to the selected printer.

Recipients
This option specifies whether you want to see the Recipients tied to the Carrier(s)
that you are running the report on.

Write report to file
This option specifies that the report should be written to a file instead of being sent
to a printer.

Close This button will close the report window.

Apply This button will run the report.
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5.8 Help

The
Help
menu
for
NoteP
ager
Pro
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ability 
to run
four
types
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reports
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5.8.1 Contents

You are here.
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5.8.2 Keyboard Shortcuts

5.8.3 Mouse Shortcuts

5.8.4 Register

Note: If you have already registered the program, this menu option will not appear.

After purchasing NotePager Pro, you will be sent a registration key. That registration key will need to be
typed in to this section of the program.



The Menus 165

© 2001-2015 NotePage, Inc.

NOTE: The registration information is both case and punctuation sensitive and it must be typed in
precisely as it is shown in what you were sent.

5.8.5 Website

Clicking this menu option will open your default web browser and take you to our website (http://
www.notepage.net). 

5.8.6 Folders

This menu option will display the file path for the Program and Database directories.

5.8.7 About

This menu option will show a dialog that displays the version information of NotePager Pro as well as
your registration information, if you have registered the program. If you have not registered the program, it
will prompt you for a registration key and remind you that you are running the trial version.

http://www.notepage.net)
http://www.notepage.net)
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6 Reference

The reference section provides a definition for some of the terms used when interacting with NotePager
Pro.

6.1 Ad-Hoc

Ad-Hoc messages are messages that are sent to a recipient that isn't actually setup in NotePager Pro.  By
using Ad-Hoc, messages can be sent to a recipient by choosing the recipient's paging carrier (by choosing the
carrier's ad-hoc recipient that must already be setup in NotePager Pro) and providing the ID/PIN number for the
recipient's pager (or other wireless messaging device).  Ad-Hoc recipients that have been setup in NotePager
Pro will show up at the beginning of the 'Recipient List' and will have the text '(A)' before their name.  If you
choose an Ad-Hoc recipient, you will be prompted for the recipient's ID/PIN number before the entry is moved
into the 'Selected Recipients List'.

6.2 Bad

The 'Bad' status number on the main NotePager Pro screen shows how many messages produced errors
when being delivered.  These messages were not successfully sent to the recipient's pager.  By clicking on the
'Bad' label, you can bring up the full 'Bad Messages' log.  See 'Bad Messages' for more information about this
log.

6.3 Bad Messages

The 'Bad Messages' log shows information about messages that have received errors while being delivered. 
Information is only shown for messages sent during the current session of the NotePager Pro.  This log
displays whom the message was sent to, when it was entered, the current message status, and the beginning
of the actual message.  The 'Refresh' button will update the displayed information.  The 'Requeue' button will
change the highlighted message's status from 'bad' back to 'pending' (the message will be resent).  The
'Close' button will close the log screen.  The 'Bad Messages' log can be accessed by choosing 'Bad' form the
'View' menu, or by clicking on the 'Bad' label on the NotePager Pro's main screen.

6.4 Carrier

A carrier is a company that provides the service for a wireless device (pager, phone, PIM, etc.).  They control the
antennas, satellites, broadcast, and computer systems that are used to send the messages to your pager. 
You may purchase your service from a reseller who represents several different carriers.  They resell the
paging service, but are not actually the carrier.  When setting up NotePager Pro, you will need some information
about the actual carrier that your wireless device is serviced by (see the installation part of the documentation
for specifics).

6.5 Characters

NotePager Pro has a character counter that displays on the main screen.  It updates itself as a message is
typed into the 'Message Text' area.  This number in not necessarily the exact number of characters sent out in
the actual message.  The sender's name may be added to the beginning of each message depending on
settings for each recipient.  Also,  some options add more information to the message before it is sent out. 
The maximum number of characters that the message box will accept can be set by going to 'Tools' ->
'Settings' -> 'Display'.
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6.6 Clear

Two 'Clear' buttons appear on NotePager Pro's main screen.  The 'Clear' button immediately to the right of the
'Selected Recipients' list, clears all the selected recipients.  The 'Clear' button immediately to the right of the
'Message Text' box, clears any text in its box.

6.7 Clear on Send

If the 'Clear on send' setting in NotePager Pro's setup screen is enabled, whenever a message is sent by the
user, the 'Selected Recipients' list and the 'Message Text' box will be automatically cleared.  Otherwise, these
two display boxes are left in their previous state, when a message is sent.

6.8 Connection Monitor

The Connection Monitor shows you, in real time, the communication session between NotePager Pro and the
wireless carriers.  This is especially helpful when first setting up and testing new carriers and recipients.  This
same information can be viewed after-the-fact in the dialer log file.  The log can be view by choosing 'Dialer Log'
from the 'View' menu.

If you close the Connection Monitor, it can be displayed again by choosing 'Connection Monitor' from the 'View'
menu.

Right-clicking in the log area of the Connection Monitor will toggle 'autoscroll' on and off.  When autoscroll is on,
the Connection Monitor's log will automatically scroll so the most current information is always showing.

6.9 Copy

A message that is scheduled, pending, or has already been sent, can be copied back onto NotePager Pro's
main screen so it can be modified and re-sent.  This option is available from the scheduled, pending, sent, bad
and history logs (available from the view menu).

6.10 Display Options

The Display Options setup screen  is accessible from 'Settings' option under the 'Tools' menu.  These settings
control how some of NotePager Pro's information is displayed.  Also, some of these settings allow you to
disable a few of NotePager Pro's features.  This can be useful if a simplified user interface is desired for end
users.

Comment Label: Each recipient or group has two user-defined fields associated with them.  By default these
fields are labeled 'Comment1' and 'Comment2'.  You can change these labels to something more meaningful.

Max Msg Length: The number of characters that the message box on the main screen can be limited by
changing this value.

Remove Preset Buttons:  This option will remove the programmable message buttons on the NotePager Pro
window.

Remove Option button:  This option will remove the 'Options' button from the NotePager Pro window.  This will
remove the end user's ability to send scheduled and repeating messages.

Remove Logs: This option will prevent the user from being able to view NotePager Pro's log files.

Remove Reports: This option will prevent the user from being able to view or print reports.
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Small Recipient Font: This option will use a smaller font in the 'Recipient List' and 'Selected Recipients'
listboxes.

Failure Warning Popup: This option will cause NotePager Pro to display a large red failure warning box if a
message can't be delivered.

Clear on Send: When this option is checked, the list of selected recipients and the message text will be
automatically cleared each time a message is sent.

Display group label: Groups are distinguished from regular recipients in the Recipient list by being prefixed
with the letters '(G)'.  If desired, this label can be moved to the end of the group's name.

Minimize To: When NotePager Pro's main screen is minimized, it can do one of two things.  It can either put an
icon in the Windows system tray, or it can minimize to the Windows task bar.

6.11 Enable Spell Check

The 'Enable Spell Check' checkbox is used to enable/disable the message spell checking option.  The
NotePager Pro can use Microsoft Word's spell checking dictionary.  MS Word 97 or newer is required.  The
'Enable Spell Check' setting is located on the 'General Settings' screen found under the 'Tools' -> 'Settings'
menu.

6.12 Exporting

NotePager Pro can export information to several different destinations:

NotePager Pro - There is no need to export information between versions of NotePager Pro.  Any database
from an earlier version will be automatically upgraded if this version is installed to the same folder as the
previous version

NotePager Net - Many companies upgrade from NotePager Pro to NotePager Net (a client/server network
version of NotePager Pro).  This option makes moving your existing settings into the network version easy.

PageGate - Many companies upgrade from NotePager Pro to PageGate (a wireless messaging server with
many interfaces and features).  This option makes moving your existing settings into PageGate easy.

WebGate - Many companies upgrade from NotePager Pro to WebGate (a wireless messaging server with
Internet gateways).  This option makes moving your existing settings into WebGate easy.

Text File - NotePager Pro can write its settings out standard comma delimitated text files. 

6.13 Filtering (Searching)

The 'Recipient List' on NotePager Pro's man screen can be filtered to only display a small group (or single) of
recipients.  This is very helpful if you have a long recipient list.  Filtering can also be used to find recipients that
match the user-defined fields that are associated with each recipient and group.

To filter the Recipient List, simply right-click somewhere in the Recipient list, and then enter information in the
window that pops up that you want the recipients to meet.  Leave all the fields blank to remove any active filter
and display the full recipient list again.
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6.14 General Settings

The 'General Settings' contains general program setting.

The 'Sender's Name' field allows you to set the name of the operator of this workstation.  Each message sent
by NotePager Pro is prefixed with the name of the sender. You can set the sender's name to %LoginName% to
have NotePager Pro automatically use the currently logged in username for the sender.

The 'Max Log Length' field sets the maximum length that the dialer log will grow to (in bytes).

The 'Purge After' setting is used to set how long message history will be kept in the NotePager Pro database
file.

The 'Detailed Log' setting enabled (or disables) the logging of detailed communications information in the
dialer log.

The 'Archive Log' option, when enabled, renames each day's dialer log with the date.  This is used if you need
to keep a log of all messages sent out each day.

The 'Enable Spell Check' checkbox allows you to enable the spell checking option in the NotePager Pro.  In
order to use this option, you must have Microsoft Word 97 or newer installed on your system.

The above settings can be saved so that all users of this workstation will use these settings, or so that only the
currently logged in user uses these settings.  This applies to most of the other settings screens too.

6.15 Groups

Messages can be sent to a pre-defined group of recipients.  Groups will show up at the beginning of the
'Recipient List' and will have the text '(G)' before their names.  When you send a message to a group, the
message will be delivered to all the members of the group.

6.16 History

The 'History' shows information about all messages sent from this workstation.  You have options of printing
the log to a printer, or copying the log to your computer's clipboard for use in another application.  Messages
can also be requeued and copied from the history screen.

6.17 Importing

NotePager Pro can import information from several different sources:

NotePager32 - You would use this if you are upgrading from NotePager32 to NotePager Pro

NotePager Pro - There is no need to import from previous versions of NotePager Pro.  Any database from an
earlier version will be automatically upgraded if this version is installed to the same folder as the previous
version

PageGate - It is common for companies that are using PageGate to use NotePager Pro on their portable
computers, when not connected to the company's network.  Importing the settings from PageGate into
NotePager Pro will keep the portable computers up-to-date.

Text File - NotePager Pro can import settings from standard comma delimitated text files.  This enables
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NotePager Pro to accept information from other applications or data sources.

6.18 InitStrings

What is an init string?
Different modems can't necessarily talk to each other as set right out of the box.  Modems use many different
settings and protocols.  In order for two modems to communicate, they must agree on many things such as
speed, error correction, compression algorithms, etc...  By sending a modem an init string, you can control
some of these parameters.

What do I need to put in my init string?
In general, the modems used by paging carriers run at a speed from 300 to 2400 baud (1200 being the most
common).  They don't typically use any form of error correction or data compression protocols.  In many cases,
if your modem tries to use either of these protocols, your modem will be unable to communicate with the
paging terminal's modem.  In your init string you should include settings to lock you modem's baud rate to that
of your carrier's modem, disable error correction protocols, and disable data compression protocols.  In
addition NotePager Pro would like your modem to issue English response codes (rather than numeric
response codes), and issue complete connection information.

Do all modems use the same init string?
No, many different modem manufacturers use their own set of modem commands.  Init strings may even be
different between models by the same manufacturer.

My init string works on one carrier but not the other.
You may need a different init string to connect to each carrier.  In general your init strings will be the same, but
not always.

What init string should I use?
There is no easy answer to this.  In general, if your modem is a 2400 baud model or slower (very old models)
you won't need an init string.  These older modems sometimes work best when communicating with the
paging terminals.  Anything faster (9600, 14.4, 28.8, 33.6, 56K, etc.), will probably require an init string.  Some of
the most common init strings are listed below.  If you have a less well known brand modem, you may need to
use the documentation include with you modem to create an init string.

Common Init Strings

AT&FQ0V1X4&D2   - Minimal settings.  Works with most 1200 and 2400 baud modems. Some modems use
&F0 rather than &F.  All '0' are zeros not oh's.

AT&FQ0V1X4&D2N0S37=5   - Hard coded baud rate.  Works with many 14.4 and 28.8 modems.  The added
codes locks the connection baud rate to 1200 baud.  Use S37=3 for a 300 baud connection, and S37=6 for a
2400 baud connection.  Some modems use &F0 rather than &F.  All '0' are zeros not oh's. 

AT&FQ0V1X4&D2N0S37=5\N0%C0   - No compression/error correction.  Works with many 14.4, 28.8 and 33.6
modems.  The added codes turn off data compression and error correction.  You can try using only one of the
two additional codes (\N0 or %C0) if you modem rejects using both.  Use S37=3 for a 300 baud connection,
and S37=6 for a 2400 baud connection.  Some modems use &F0 rather than &F.  All '0' are zeros not oh's.

AT&F0Q0V1X4&D2&B1&K0&M0&N2   - US Robotics (3Com) string.  Works with most US Robotics/3Com 33.6
and 56K modems (and some others too).  Use &N1 (instead of &N2) for a 300 baud connection, or &N3 for a
2400 baud connection.

AT&FQ0V1X4&D2N0+MS=B103  - This string has been found to work with some of the newer winmodems.  Set
the baud rate to 300 when using this string.

Note: all '0' characters in the init strings are zeros not oh's
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***More init strings may be available on our web site: www.notepager.com

6.19 Message Content

Messages sent by NotePager Pro are sent with more information than just the message itself.  Messages will
be prefixed with the the block number (if it is part of a large message that has been broken into smaller pieces.
 i.e. 1 of 3, 2 of 3, 3 of 3), the sender's name (optional), and then the message itself.  Each of these fields is
separated with a colon (:).  Most pagers have a limited character set usually consisting of upper and lower case
letters, numbers, and some symbols (periods, commas, dollar signs, exclamation points, etc.).  Non printing
characters such as carriage returns, line feeds, tabs, and some symbols are not commonly supported.  By
default the NotePager Pro Server will strip all non-printable characters from the messages.  Non-printable
characters can be sent as part of the message by unchecking the 'Drop non-printable characters' option on the
recipient's setup screen.

6.20 Message Text

The 'Message Text' area is where the actual message to be sent is typed.  Commonly used messages can be
automatically entered by hitting one of the 'Prog1' - 'Prog5' buttons (see 'Presets' for information on settings and
use of these buttons).  A character counter is displayed above the 'Message Text' area.  If spell checking is
enabled (see 'Spell Checking'), it can be invoked by double-clicking anywhere in the 'Message Text' area.

6.21 Modem Settings

The 'Modem Settings' screen allows you to change settings that control how NotePager Pro uses your modem.

The 'Modem Port' field is used to set the serial port that your modem is attached to.

The 'Dialing Prefix' field is used if the phone line your modem is using requires a code to be dialed to get an
'outside' dialtone.  The most common setting for this (other than leaving it blank) would be: 9,

The 'Retries' field sets the number of times a failed message should be retried before the message is
permanently marked as bad.

The 'Retry Interval' field sets how long NotePager Pro should pause (in seconds) between retries.

6.22 Notify Only

Recipients in NotePager Pro can be set to 'Notify Only'.  When this option is enabled, a predefined (settable)
message (notification code) is sent instead of the actual message.  This is most often used with numeric
pagers. 

6.23 Numeric Pagers

Some pagers are only capable of displaying numbers (no letters).  These are commonly called numeric or
digital pagers (beepers).  NotePager Pro fully supports numeric pagers.  If a message is sent to a numeric
pager, and the message contains letters, the recipient's notification code (999 by default) is sent instead.  This
alerts the recipient that they have been sent a message that was alphanumeric in nature, and they should take
steps to retrieve the actual message. 
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6.24 Options

The 'Options' button brings you to the 'Advanced Message Options' screen.  From here, scheduled and
repeating messages can be setup.  To schedule a page to be sent at a future date and time, fill in the 'Send
Message When' fields.  To schedule a message to be sent repeatedly, fill in the 'Send Message When' fields
for when you want the first page to be sent.  Fill in the 'Resend Messages Every' fields to set the interval at
which the message is to be repeated.  Finally, fill in the 'Stop Sending Message' fields to set the date and time
for the message to stop being sent.

6.25 On-Call Groups

NotePager Pro has a feature built into it that can be very useful in an on-call service environment.  After
recipients are added to a group, a schedule of recipients can be setup defining when each recipient is on-call
(starting day and time, and ending day and time).  When a message is sent to the group, the schedule is
consulted to see which recipient or recipients the message should be sent to.  This way, only the recipients
that are scheduled to be on-call receive the page.

6.26 Pager (Beeper)

Throughout NotePager Pro's documentation the word 'pager' is used.  'Pager' is better defined as 'wireless
messaging device'.  NotePager Pro can be used to send messages to many devices other than pagers.  For
example messages can be sent to digital/cellular/mobile/pcs phones, pager cards for portable computers,
Personal Information Managers (PIMs), billboards, and many other wireless messaging devices.

6.27 Passwords

The 'Password Setup' screen is accessed by choosing 'Tools' -> 'Settings' -> 'Passwords' from NotePager
Pro's menu.

Admin Password - If you set an Admin Password, users will be required to enter it to access any of the setup
screens.  The Admin Password will also work in place of either of the other two passwords.

Super User Password - If you set a Super User Password, users will be required to enter it to access the
carrier, recipient, and group setup screens.  The Super User Password will also work in place of the User
Password.

User Password - If you set a User Password, users will be required to enter it in order to start the NotePager
Pro program.

6.28 Pend

The 'Pend' status number on the main NotePager Pro screen shows how many messages are still waiting to
be sent by NotePager Pro.  By clicking on the 'Pend' label, you can bring up the full 'Pending Messages' log. 
See 'Pending Messages' for more information about this log.

6.29 Pending Messages

The 'Pending Messages' log shows information about messages that are waiting to be sent by NotePager Pro.
 This log displays whom the message was sent to, when it was sent to the paging server, the current message
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status, and the beginning of the actual message.  The 'Refresh' button will update the displayed information. 
The 'Cancel' button will cancel the highlighted message.  The 'Edit' button will allow you to temporarily suspend
the message, make changes to it, and then re-send it.  The 'Copy' button will copy the message information
back into the main NotePager Pro screen (without affecting the currently pending message).  The 'Close' button
will close the log screen.  The 'Pending Messages' log can be accessed by choosing 'Pending' form the 'View'
menu, or by clicking on the 'Pend' label on NotePager Pro's main screen.

6.30 Pre-programmed Messages

Up to one hundred frequently used messages can be pre-programmed for your convenience.  The first five of
these can accessed with a single click on the main screen. These messages can be automatically inserted
into the 'Message Text' area by clicking on the 'Prog1' - 'Prog5' buttons.  The rest of the pre-programmed
message are accessed by clicking on the 'More' button.  The first five pre-programmed messages can be set
by right-clicking on its button.  To bring up the 'Preset Messages' screen, which displays all the pre-
programmed messages, click on the 'More' button, or choose 'Tools' -> 'Presets' from the menu.

Each pre-programmed message can also, optionally, be assigned a recipient or group.  This option will not
only add the programmed message text to the main screen, but will also automatically select a recipient or
group to send the message to.  

6.31 Protocols

NotePager Pro supports seven different protocols to deliver messages to wireless carriers.  You will need to
contact your carrier to verify what protocols they support.  You can also find protocol support information for
many carriers in the support section of our website (www.notepager.com).

FAX - This protocol allows NotePager Pro to send a fax.

FAXSRV - This protocol allows NotePager Pro to use a Microsoft Fax Server.

GSMAT - This protocol was initially defined as part of the GSM protocol.  It uses AT Commands to communicate
with mobile phones and wireless modems that are directly connected to your computer (usually to the serial
port).  This protocol can be used to send messages totally wirelessly: from your wireless device (phone or
modem), directly to the recipients's device.

SMTP - (Simple Mail Transfer Protocol) This is the same Internet based protocol that is used for regular email. 
Although most wireless carriers support this protocol, it shouldn't be your first choice.  Using SMTP can result
in delays in delivery, and there is no confirmation that the carriers has even accepted the message.

SNPP - (Simple Network Paging Protocol) This is an excellent Internet based protocol.  It has all the
advantages of TAP, but tends to be faster.

TAP - (Telocator Alphanumeric Protocol) The is probably the oldest, and most widely used modem based
wireless messaging protocol.  Previous versions of TAP were named IXO and PET.  NotePager Pro supports
all of these standards.

TONE - (Touch Tone) Although not really a protocol, touch tone delivery is still exclusively used for many
numeric pagers.

UCP - (Universal Computer Protocol) A modem-based protocol that is used mostly in Europe.

WCTP (Wireless Communications Transfer Protocol) Another Internet based wireless messaging protocol.  It's
not quite as widely accepted as SNPP.

http://www.notepager.com)
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6.32 Recipient List

The 'Recipient List' listbox is displayed on the NotePager Pro's main screen.  It lists the recipients that can be
chosen to send messages to.  Recipients are listed alphabetically by the recipient's full name.  Groups are
listed before single recipients and are prefixed with a (G) label.  Recipients are moved from the 'Recipient List'
to the 'Selected Recipients' list by clicking on the recipient's name.  You can also select recipients by typing the
first few letters in their name and hitting <ENTER>.  This only works if the 'Recipient List' is the active control
(has the focus).  Set the focus to the 'Recipient List' by clicking on the 'Recipient List' heading, or by hitting <Ctrl-
R>. Once a recipient is selected, it is moved from the 'Recipient List' box to the 'Selected Recipients' box.

If you shift-click on a recipient or group, you can view more detailed information about that recipient or group
(including members in the case of the group).

If you right-click in the recipient list, you can filter which recipients show up in the list.

6.33 Recipients

In NotePager Pro, 'recipient' is synonymous with 'pager' (or other wireless messaging device).  A recipient is
the person who carriers the actual pager.  When NotePager Pro refers to a 'recipient' it is really referring to the
recipient's pager.  This approach simplifies things for the end users.  For example if a user were to replace
their pager with a new unit, the recipient name will stay consistent, even though the pager's information would
change.

6.34 Reports

NotePager Pro can generate many useful reports.  Each report has several options of what to display and how
to display the information.  All reports can be previewed on your screen before they are printed.  Also, all reports
can be saved to a standard text file, instead of printed.

Sent Messages - These reports will show information about messages that have already been sent (both
successful and failed messages).  There are three different ways to view this information:
  By Recipient - Messages are grouped by which recipient they were sent to
  By Date/Time - Messages are listed in the order they were sent out
  By Carrier - Messages are grouped by which carrier they were sent to

Scheduled Messages - These reports show messages that have not yet been sent out.  These are typically
messages that were scheduled to be sent in the future, or messages that repeat.  There are three different
ways to view this information:
  By Recipient - Messages are grouped by which recipient they were sent to
  By Date/Time - Messages are listed in the order they were sent out
  By Carrier - Messages are grouped by which carrier they were sent to

Statistics - The statistics reports show useful information about the deliver of messages, such as average
delivery times, failure rates, etc.
  By Recipient - Messages are grouped by which recipient they were sent to
  By Date/Time - Messages are listed in the order they were sent out
  By Carrier - Messages are grouped by which carrier they were sent to

Lists - These reports print information about the carriers, recipients, and groups that are setup in NotePager
Pro.
  Recipient List - lists information about each recipient
  Group List - lists information about each group including (optionally) the members of each group
  Carrier List - lists information about each carrier including (optionally) the recipients that use each carrier
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6.35 Scheduled and Repeating Messages

Selecting the 'Options' button on the NotePager Pro's main screen will display a window where you can
schedule messages to be sent in the future, and messages that will be sent repeatedly.  To schedule a page
to be sent at a future date and time, fill in the 'Send Message When' fields.  To schedule a message to be sent
repeatedly, fill in the 'Send Message When' fields for when you want the first message to be sent.  Fill in the
'Resend Messages Every' fields to set the interval at which the message is resent.  Finally, fill in the 'Stop
Sending Message' fields to set the date and time for the message to stop being sent.

6.36 Scheduled Msgs

The 'Scheduled Messages' screen can be accessed by clicking on the 'Sched' label on NotePager Pro's main
screen, or by choosing 'Scheduled' from the 'View' menu.  This option allows you to make changes to a
message that has been scheduled for delivery, but hasn't been sent yet.

To edit a scheduled message, highlight a message entry on the 'Scheduled Messages' screen and then hit the
'Edit' button.  A message box will appear to let you know that this message will not be delivered until you hit the
'Send' button again (even if you don't make any changes).  the data from the message you selected will be filled
into the regular NotePager Pro screen.  Make the necessary changes and then resend the message by hitting
the 'Send' button.

6.37 Selected Recipients

The 'Selected Recipients' list box is displayed on the NotePager Pro's main screen.  It lists recipients (pagers)
that the next message will be sent to.  Recipients are added to the 'Selected Recipients' list by choosing them
from the 'Recipient List' box (see 'Recipient List' for more details).  You can remove a single recipient from this
list by simply clicking on the name of the recipient.  Clicking the 'Clear' button to the right of the 'Selected
Recipients' box, will clear all the recipients in the list.

6.38 Send

Clicking on the 'Send' button will send the message in the 'Message Text' area to all the recipients (pagers) in
the 'Selected Recipients' list.  The 'Send' button will animate to confirm your mouse click on the button.  The
'Message Text' and 'Selected Recipients' boxes are not cleared after clicking 'Send' (unless the 'Clear on Send'
option in the setup screen is enabled), enabling you to resend the message if needed.  To clear either of these
boxes, simple click the 'Clear' button to it's right.

6.39 Sender's Name

The 'Sender's Name' is sent at the beginning of each message, so the recipient knows who the message is
sent from.  A short name should be used because most pagers only display a limited number of characters on
their screens.  The 'Sender's Name' setting is located on the 'Tools' -> 'Settings' -> 'General' screen.  If you want
NotePager Pro to use the currently loggon on user for the sender's name, put %LoginName% in the sender
field.

6.40 Sent

The 'Sent' status number on the main NotePager Pro screen shows how many messages have been
successfully sent by this workstation.  By clicking on the 'Sent' label, you can bring up the full 'Sent Messages'
log.  See 'Sent Messages' for more information on the log.
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6.41 Sent Messages

The 'Sent Messages' log shows information about messages that have been sent.  Information is only shown
for messages sent during the current session of the NotePager Pro.  This log displays whom the message
was sent to, when it was sent to the paging server, the current message status, and the beginning of the actual
message.  The 'Refresh' button will update the displayed information.  The 'Requeue' button will resend the
highlighted message.  The 'Copy' button allows you to copy this message information back into the main
NotePager Pro screen.  The 'Close' button will close the log screen.  The 'Sent Messages' log can be accessed
by choosing 'Sent' form the 'View' menu, or by clicking on the 'Sent' label on the NotePager Pro's main screen.

6.42 Spell Check

If the spell checking option is enabled on the general setup screen, messages can be checked for spelling
errors before they are sent.  The NotePager Pro uses Microsoft Word's spell checking utility that is included in
Word 97 or newer.  MS Word must be installed in order for NotePager Pro to be able to spell check messages.
 A message can be checked by double-clicking anywhere in the 'Message Text' area, or by choosing 'Check
Spelling' from the 'Tools' menu.

6.43 Touch Tone Delivery

Touch messages are messages sent by calling a pager's phone number and sending a series of tones (like a
touch tone phone) as a message.  The tones are converted to their equivalent numbers and sent to the
recipient's pager.  Some paging carriers do not accept messages for numeric pagers via the regular TAP (IXO/
PET) protocol.  They only accept touch-tone numeric messages.  NotePager Pro  supports delivering numeric
messages in this manner, but it is not the preferred method.  This method of message delivery has no
provisions for error detection/correction or message confirmation.  It is sometimes known as 'blind dialing'
because there is no way to really know if the other end actually received the message.

How to setup a recipient for touch-tone messages:
First a 'Tone' carrier must be setup.  Only a single 'Tone' carrier may be needed to send message to all your
numeric pagers.  To make a carrier a 'Tone' carrier, choose 'Tone' as the 'Delivery Method' on the carrier setup
screen.  The default wait string ',,@' should work for most pagers.  If you need to use different wait string for
different pagers, you will need to create multiple 'Tone' carriers (one for each unique wait string needed).  The
wait string can be changed to support pagers with different input methods.

The comma (,) is used to pause (about one second)
The at sign (@) is used to wait for silence (about five seconds of silence)

The default wait string will dial the pager's number, pause for a couple of seconds, and then wait for a five
second period of silence (after the beeps or greeting message) and then send the message (touch tones).

To setup a recipient to use touch-tone delivery, simply choose the carrier you just setup as a 'Tone' carrier and
put the numeric pager's phone number in the 'Phone Num' field on the recipient setup screen.  If you have
setup several carriers with different wait strings, choose the carrier that will work with this pager's service
provider.  With this setup, NotePager Pro will dial the phone number setup in the recipient's 'Phone Num' field,
pause according to the commas or @ in the carrier's 'Wait String' field, and then send the touch-tone message.

Some paging providers use a common phone number for all numeric pagers.  The user must dial this number,
wait for a tone, dial their pager's ID number, wait for another message, and then type the numeric message. 
This can be accomplished in NotePager Pro by setting the 'Tone' carrier's wait string to wait a predetermined
amount of time (using commas and or an @ symbol).  This would  be the wait time between sending the
pager's phone number and sending the actual touch-tone message.  On the recipient setup screen, in the
recipient's 'Phone Num' field, put the paging company's common phone number followed by a few commas or
an @ symbol, and then the pager's phone number.  This will give the following results:  The phone number will
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be dialed from the first part of the recipient's ID/PIN field,  NotePager Pro will pause according to the commas
or @ in the 'Phone Num' field, NotePager Pro will then send the second set of number in the recipient's 'Phone
Num' field and then pause according to the carrier's wait field.  NotePager Pro will then send the touch-tone
message.
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7 Troubleshooting

For assistance, please visit our support site at http://www.notepage.net/support.htm and our support
forum at http://www.notepage.net/forum/ 

Technical support is available from 9:00 AM to 5:00 PM Eastern Time and can be reached at:

support@notepage.com
http://www.notepage.net/forum/ 

http://www.notepage.net/support.htm
http://www.notepage.net/forum/
mailto:support@notepage.com
http://www.notepage.net/forum/
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